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Copyright, Trademark, and FCC
Information

Copyright

This document is copyrighted by Osprey Technologies, Inc., a wholly-owned
subsidiary of ViewCast Corporation. No part of this specification may be reproduced,
transcribed, transmitted or stored in a retrieval system in any part or by any means
without the express written consent of Osprey Technologies, Inc.

Disclaimer

Osprey Technologies, Inc. reserves the right to change any products herein at any
time and without notice. ViewCast Corporation and Osprey Technologies, Inc. make
no representations or warranties regarding the content of this document, and
assume no responsibility for any errors contained herein.

Trademark Acknowledgment

Osprey-500 DV, Osprey-500 PRO, and Osprey-500 DV PRO are trademarks of Osprey
Technologies, Inc. Microsoft, Windows XP, Windows 2000, Windows NT, NetMeeting,
NetShow, and Video for Windows are trademarks or registered trademarks of
Microsoft Corporation. Any other product names, trademarks, trade names, service
marks, or service names owned or registered by any other company and mentioned
herein are the property of their respective companies.

FCC Notice
For assemblies whose part number ends in -02 and higher, the following applies:

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses, and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation.

If this device does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to
try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the computer and the receiver.

Connect the computer into an outlet on a circuit different from that to which
the receiver is connected.

¢ Consult the dealer or an experienced radio/TV technician for help.



For assemblies whose part number ends in =01, the following applies:

This equipment has been tested and found to comply with the limits for a Class A
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can
radiate radio frequency energy and, if not installed and used in accordance with the
instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his
or her own expense.

An example part number for Class A is 92-00109-01.

An example part number for Class B is 92-00109-02.
Shielded Cables

Connections between this device and peripherals must be made using shielded
cables in order to maintain compliance with FCC radio emission limits.

Modifications

Modifications to this device not approved by Osprey Technologies, Inc. could void the
authority granted to the user by the FCC to operate the device.
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Chapter 1 - Getting to Know the Osprey-500 Capture Cards

Chapter 1 - Getting to Know the Osprey-
500 Capture Cards

The Osprey-500 Capture Driver User’s Guide provides practical information for
installing and configuring the hardware and software for the Osprey-500 DV, Osprey-
500 PRO, and Osprey-500 DV PRO devices. This guide has been designed with the
needs of the end user in mind, particularly first-timers and those working with
existing applications.

Symbols

Introduction

Three Versions of the Osprey-500
Features

Software Included

Compatible Third-Party Applications
Getting Help

Symbols

& This symbol denotes an important note or warning.

This shortcut icon points more experienced users to sections or chapters
that summarize step-by-step instructions.

Introduction

The Osprey-500 is the first professional-grade video capture card designed
specifically for streaming. Developed in collaboration with Microsoft, the Osprey-500
provides higher quality audio and video than traditional analog audio/video capture
devices. Particularly notable, the Osprey-500 provides this data to the host in
formats most optimal for encoding without additional CPU utilization, thus leaving
more CPU bandwidth for the actual encoding process.

Osprey-500 User's Guide - Version 2.2.0 11
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The Osprey-500 provides to the host application the following:

Digital Video from an SDI video source

Decompressed DV video from IEEE-1394 DV video devices
Video from S-video/Composite sources

Digital Audio from a digital audio source (AES/EBU, S/P-DIF)
Digital Audio from IEEE-1394 DV video devices

Audio from Balanced or Unbalanced analog sources

* & 6 6 o o

The Osprey-500 also offers optional hardware based video processing.

_ _ Direct Memory
— g De-interlacing . ploolor Space 1w Access (DM —w
Spatial/Termparal Scaler Conversian / to host /
Filter Feformatter WA device

In hardware the Osprey-500 can scale and color convert video, and it can perform a
video filter operation. The filter is basically a de-interlacing operation. The benefit of
the de-interlacing operation is twofold:

+ Provide full resolution de-interlacing of video from interlaced sources, thus
eliminating typical interlaced artifacts.

¢ Provide more motion content in resolutions less than or equal to CIF. In
typical existing video capture devices, resolution captures of less than or
equal to CIF resort to only a single field capture. The video filter provides for
higher motion content than a single field capture without jagged/stair-step
edges.

Starting with Software Release 1.0.6, the Osprey-500 can be utilized with any VFW
or DirectShow based audio/video application. For example, the Osprey-500 can be
used with:

Windows Media Encoder to produce .asf and .wmv encoded files
RealProducer to create .rm encoded files

Sorenson Broadcaster to create QuickTime encoded files

and a variety of AVI based capture programs to generate .avi files.

* & o o

Starting with Software Release 2.1, the Osprey-500 is SimulStream capable.
SimulStreaming is an added-cost upgrade that allows the driver to capture and
display video and audio to multiple destinations from a single card. Please see the
SimulStreaming User’s Guide which is installed in the Osprey 500 Program group for
details about this feature.

12 Osprey-500 User's Guide - Version 2.2.0
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Three versions of the Osprey-500

Osprey-500 DV

Enables real-time streaming from a digital video (DV) source. The Osprey-500 DV
actually decodes DV video on the card, optionally scales and color converts the
resultant digital video, and transfers the digital video directly to the host. The host
CPU can then be used to encode the data for streaming. This is far superior to most
IEEE-1394 DV solutions which capture DV data to the host. In these systems, the
host CPU must first decode, scale, possibly color convert, and reformat the data
before it can encode it for streaming. Decoding on the Osprey card leaves the bulk of
your CPU power for creating higher-quality video streams.

Osprey-500 PRO

Captures digital video and audio in the formats produced by professional-level
camera and production equipment, including SDI video and professional digital
audio. Previous to the Osprey-500 PRO, the only method available to many
professionals for efficiently supplying data to streaming encoders was to first convert
digital video and audio to analog and then capture the converted data using analog
capture cards. The Osprey-500 PRO significantly improves quality by completely
eliminating this need to go from high quality digital sources to analog.

Osprey-500 DV PRO
Includes all the features of both the Osprey-500 PRO and the Osprey-500 DV.

Features

The Osprey-500 is a single-slot card that delivers uncompressed digital video and
audio to media applications. It includes digital video preprocessing in hardware that
can significantly improve video quality for streaming applications.

The variety of video and audio inputs supported by the Osprey-500 allows it to meet
quality demands across a wide spectrum of professional and prosumer users.

Audio/Video Specifications

Video Frame Rates and Performance

Osprey-500 User's Guide - Version 2.2.0 13
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Audio/Video Specifications

Video Input

Audio Input

Audio Processing

Hardware Video Processing

Computing Platforms

Hardware System

Video Input

* & & o o

NTSC/PAL'

Composite (BNC style)

S-Video (Mini-Din style)

DV (via IEEE-1394 connector)
SDI (SMPTE-259M)? (BNC style)

Audio Input

* & 6 o o

Unbalanced stereo (RCA connectors)

Balanced stereo (XLR connectors)

Professional digital audio AES/EBU (XLR connector)
Consumer digital audio (S/P-DIF Optical/RCA connectors)
DV Audio (via same IEEE-1394 connector as DV Video)

Audio Processing

¢
.
.

Auto sample rate selection for analog inputs (32 kHz/44.1 kHz/48 kHz)
Audio sample rate down conversion based on application requirements
Audio sample rate up conversion based on application requirements

Hardware Video Processing

* & o o

Temporal/spatial de-interlacing filter
DV decoding

Video scaling

Color space conversion

14
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Computing Platforms

¢ Windows 2000 Professional
¢ Windows XP
¢ Windows NT 4.0

Hardware System

¢ 32-bit/5-volt PCI card
¢ Full PCI Rev. 2.2 compliance
¢ Multi-board support

Notes:

1. PAL is supported in Software Releases 1.02 and later.
2. Embedded Digital Audio in SDI is not supported in the Osprey-500 Hardware.

Video Frame Rates and Performance

The Osprey-500 can deliver to the host 30 frames per second (fps) full resolution
NTSC (720x480) as well as 25 fps full resolution PAL (720x576). The Osprey-500
uses Direct Memory Access (DMA) to efficiently perform this delivery of both video
and audio data to the host. Once the data is in host memory, performance is directly
affected by how the data is processed. The different encoding options of the
Windows Media Encoder have varying CPU requirements and are outside the scope of
this manual.

The Osprey-500 also supports DirectDraw for displaying video with minimal load on
the system processor.

It should be noted that uncompressed video bandwidth is very large. Video at
640x480 with a 16bit color format at 30fps results in more than 18Mbytes/sec of
data transfer across the PCI bus. Thus PCI bandwidth issues, which may result due
to other high bandwidth demanding devices on the PCI bus, can limit performance.
For example, having PCI based SCSI controllers may consume large amounts of PCI
bandwidth if lots of SCSI disk activity is occurring.

Osprey-500 User's Guide - Version 2.2.0 15
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Software Included

The products for Windows 2000, Windows XP, and Windows NT 4.0 include:

¢ A Video for Windows compatible video capture driver capable of being
upgraded to SimulStream

An audio Mixer and an audio Wave driver

VidCap32 - a simple video capture application allowing for capturing and
viewing the various video features of the device

¢ A variety of other software applications (Windows Media encoder, Windows
Media Player, RealProducer, RealPlayer, etc.). Note that these are only
available on the CD-ROM and not on the web-based software release.

Beginning with Version 2.1, the driver is SimulStream capable. SimulStreaming is an
added-cost upgrade that allows the driver to capture and display video and audio to
multiple destinations from a single card. Please see the SimulStreaming User’s Guide
which is installed in the Osprey 500 Program group for details about this feature.

Compatible Third-Party Applications

The Osprey-500 was initially designed exclusively for Microsoft Windows Media
applications. Starting with release 1.0.6, the Osprey-500 works with any audio/video
VFW or DirectShow based application.

Getting Help

Before contacting support, please do the following:

+ Work through the section of Chapter 3 entitled Testing the Installation for
Windows 2000, Chapter 4 entitled Testing the Installation for Windows
XP, or Chapter 5 entitled Testing the Installation for Windows NT.

Read through Chapter 9 - Troubleshooting.

Visit our web site at http://www.ospreyvideo.com/ and read the Osprey-
500 FAQs by selecting Support > Osprey Product Line > FAQs.

If you have done that and you’re still having problems, contact the Osprey Support
Group at:

Voice, toll free (888) 684-6622
Voice (919) 319-9200
Fax (919) 319-9814
E-mail mailto:support@ospreyvideo.com

16 Osprey-500 User's Guide - Version 2.2.0
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When you contact support, especially if it is by email, please include the following
information:

L2

Which product you have — Osprey-500 DV, Osprey-500 PRO, or Osprey-500
DV PRO.

The connectors on the back of the Osprey-500 vary between the model
numbers, either -02 or -03.

Which operating system you are using. Certain minor aspects of the Osprey-
500 drivers are different between Windows 2000, Windows XP, and Windows
NT 4.

Which version of the Osprey-500 driver you are using. The version
information is on the title bar of the driver’s Control Dialog, as well as in the
first message of the installation program.

The type of audio and video source being used (for example: SDI video and
AES/EBU audio) and the type of equipment being used as the source (for
example: a Sony A500 Digital Betacam Deck).

Any additional details about your system configuration would be helpful - for
example, the system speed, processor type, motherboard chipset, whether
you have a SCSI or IDE hard drive, whether you have a network adapter
card, and the type of display adapter card.

A detailed description of the problem.

Osprey-500 User's Guide - Version 2.2.0 17
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Chapter 2 - Osprey-500 Hardware

The Osprey-500 Capture Cards are 32-bit, 5-Volt PCI cards. They are compliant with
version 2.1 of the PCI hardware specification. The DV option of the Osprey-500 is a
daughter card. Thus the Osprey-500 DV and Osprey-500 DV PRO have both the base
card and a daughter card. Below is a picture of the Osprey-500 DV PRO (actual
hardware may differ in minor ways):

System Requirements
Configuring the Video Capture Driver
Installing the Card

Connecting Cables

System Requirements

The minimum capability of the computer for the capture card itself is fairly low. Itis
typically the application being used with the capture card that sets the minimum
requirements of the computer. For example, pure video capture applications
typically do not require hefty machines. Yet the various streaming encoding
applications, for example RealProducer or Windows Media Encoder, may require up
to dual 2 GHz processor for some of their challenging encoding profiles.

For x86 PCs, the minimum system requirements are as follows:

300 MHz Pentium II processor or higher with at least 128Mb RAM
One available PCI slot

Windows NT 4.0, Windows 2000, or Windows XP,

Approximately 7.5 megabytes of storage for system files

* & o o

For optimum performance, we recommend at least the following additional features.
Video display adapter with:

+ 4 MBytes memory minimum (8 Mbytes or more recommended)
¢ Direct Draw capability
+ An up-to-date display device driver with Direct Draw capability

With the Osprey-500 you can use on-board audio capture capability to
capture sound and multiple cards to capture multiple audio streams.

& However, you still need a sound card to monitor or play back audio since
the Osprey-500 is only a capture device and not an audio playback
device.

Osprey-500 User's Guide - Version 2.2.0 19
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Configuring the Video Capture Driver

Use the video capture application VidCap32 to access the Osprey driver Control
Dialog described in Chapter 6 - Osprey-500 Video Control Dialog.

VidCap32 is included with the Osprey package. It is useful for testing the installation
and for general purpose viewing of video. Refer to Chapter 8 - VidCap32 for
instructions on using this applet.

Installing the Card

All computer cards are sensitive to electrostatic discharge. Slight
discharges from clothing or even from the normal work environment can
adversely affect these cards. By following these simple guidelines,
however, you can minimize the chance of damaging your Osprey card.

To be used only with UL Listed computers that include instructions
for user installed accessories.

¢ Handle cards only by the non-conducting edges.

+ Do not touch the card components or any other metal parts.

¢ Wear a grounding strap while handling the cards (especially when
located in a high static area).

+ Provide a continuous ground path by leaving the power cord
plugged into a grounded power outlet.

Ensure that the workstation is powered OFF before installing any
components.

If you are not familiar with how to install a PCI bus card, refer to your
system’s documentation for more complete, step-by-step instructions.

You should install the Osprey card before installing the software driver. However,
with Windows 2000 or Windows XP you also have the option to pre-install the
software before installing the hardware.
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Use the following steps to install the Osprey card:

1.

w

®

10.

Power down the computer. Make sure that the computer’s power switch is
turned OFF. Read caution note above for grounding precautions.

Remove the computer’s cover.
Locate an empty PCI slot.

Remove the slot-cover screw from the empty PCI slot’s cover, set the screw
aside, and remove the slot cover.

Remove the card from its anti-static bag.

Install the Osprey card into the empty slot and make sure that it is seated
evenly in the slot.

Secure the backpanel of the card with the slot’s cover screw.
Replace the computer cover.

Connect video and audio cables to the Osprey card. Refer to Connecting
Cables for details of the card’s backpanel connector.

Turn the computer on.

Connecting Cables

Connecting a Composite Source

Connecting an S-Video Source

Connecting an SDI Source for the Osprey-500 PRO and Osprey-500 DV PRO

Connecting an IEEE-1394 Source for the Osprey-500 DV and Osprey-500 DV

PRO

Connecting Audio Source with the Osprey-500

The Osprey-500 DV Pro and Osprey-500 DV have been redesigned to incorporate
improvements. The newer cards have model numbers ending in -03.
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The redesigned Osprey-500 DV Pro (Model -03) has 4 connectors.

Digital (SDI) Video
@ ‘ Input

I DV Input
‘ (4 pin IEEE-1394)

Connector to breakout
‘ cable

@ Digital Audio Input
‘ (RCA style)

in)

The Osprey-500 models now ship with a breakout cable instead of a breakout box.

The Osprey-500 DV backplate does not include the SDI or digital audio
inputs.

The Osprey-500 PRO does have the IEEE-1394 connector.
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The Osprey-500 DV Pro board (Model -02) has five connectors on the back plate for

audio and video.
Digital {SDI}
™ ¥Yideo Input
(B M)

lq— D¥ Input
I (& pin IEEE-
1394)

Connector to

™ breakout box
Digital Audio
et Input
| (Optical)

Digital Audio
™ Input

[RCA)

The Osprey-500 models now ship with a breakout cable instead of a breakout box.

The Osprey-500 DV backplate does not include the SDI or digital audio
inputs.

The Osprey-500 PRO does have the IEEE-1394 connector.
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Osprey-500 Input Breakout Cable

S-Video

Unbalanced Audio
Left (RCA style)

Unbalanced Audio
’ Right (RCA style)
Composite Video
(BNC style)

Connector Styles

S-Video
RCA style

Balanced Audio
@ XLR style Right (XLR style)

Digital AES/EBU Audio

Balanced Audio
Left (XLR style)

The breakout connector has inputs for composite video, S-Video, balanced and
unbalanced audio, and professional digital audio. The breakout cable has a set (L/R)
of unbalanced RCA style audio connectors and a set (L/R) of balanced (XLR) audio

connectors. Additionally, the right XLR balanced input also is used as the professional
digital audio input.

9 The input breakout cable is ViewCast Part Number 34-05009-01.
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Osprey-500 Input Breakout Box

The Osprey-500 formerly shipped with a breakout box. The breakout box has been

replaced with a more convenient breakout cable. Here are the connector layouts for
the legacy breakout box.

BMC

) Unbalanced Balanced
Carmmposite

Audio Right Audio Right
|

AESFERU
- Crigital
Audio

l i
@ @
'

|
SWideo Unbalanced Balanced
Audio Left Audio Left

The breakout connector has inputs for composite video, S-Video, balanced and
unbalanced audio, and professional digital audio. The breakout cable/box has a set
(L/R) of unbalanced RCA style audio connectors and a set (L/R) of balanced (XLR)
audio connectors. Additionally, the right XLR balanced input also is used as the
professional digital audio input for the Osprey-500 PRO and Osprey-500 DV PRO.

9 The input breakout box is ViewCast Part Number 95-00157-01.
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Osprey-500 Input Rack-mount Panel

AES/EBI) Balanced  Unbalanced Svideo Svideno Unbalanced AES/EBU  Balanced
Digital audio audio Audio Cigital Audio
audio Left Left Left Audio Left

I

-
B[00 ® @cee/E]E

I
vy v

F'y F'y
| |
| | I |
Balanced Unbalanced BHC BHC Unbalanced Balanced
Audio Audio Composite  Cormmposite Audio Audio
Right Right Viden Widen Right Right

A rack mount version of the breakout box is also available. The 1 unit high rack
mount input box has the same inputs as the breakout box but includes two sets of
inputs. Thus a single rack mount input unit provides for two Osprey-540 cards. The
rack mount unit is pictured above.

34-05009-01.

9 The optional standard breakout cable is ViewCast Part Number
The rack-mount breakout box is ViewCast Part Number 95-00151-02.

& Exact connector layouts are subject to change.

Connecting a Composite Source

If your video source provides only composite video, connect the source’s output
cable to the Composite Video In connector. This is a BNC connector on the breakout
box. A BNC to RCA adapter is provided if you don't have a BNC composite cable.

Connecting an S-Video Source

If your video source supports S-Video, connect the source’s output cable to the S-
Video In connector on the breakout box. Compared to composite signals, S-Video
provides a sharper image with better color separation. S-Video uses a four-pin mini-
DIN connector that provides separate Y (luminance) and C (chrominance) signals.
Refer to Chapter 6 - Osprey-500 Video Control Dialog for instructions on
configuring the driver for S-Video.
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Connecting an SDI Source for the Osprey-500 PRO and
Osprey-500 DV PRO

The Osprey-500 PRO and Osprey-500 DV PRO have a BNC connector for SDI
(SMPTE-259M) video. A high quality SDI-qualified cable should be used when
utilizing this connection, especially when the cable length is long. While SDI carries
both digital video and embedded digital audio, the current version of the Osprey-500
requires the digital audio to be brought in separately through the AES/EBU digital
audio input.

The Osprey-540 supports embedded SDI audio.

Connecting an IEEE-1394 Source for the Osprey-500 DV and
Osprey-500 DV PRO

The Osprey-500 DV and Osprey-500 DV PRO have a DV input. DV carries digital
audio and video and both can be independently used by the Osprey-500.

The model -03 has a four (4) pin connector. The model -02 has a six (6) pin
connector.

Connecting Audio with the Osprey-500

The Osprey-500 has a variety of audio inputs, both analog and digital. The typical
consumer will probably find the unbalanced analog RCA audio inputs to be the most
useful. Balanced audio inputs (via XLR connectors) provide cleaner audio especially if
the cable length is very long. The prosumer may have a DV camera source and may
choose to use the audio embedded in the IEEE-1394 DV stream. For the professional
and broadcaster a choice of three digital audio inputs is available. On the base card
are S/P-DIF optical and RCA inputs. The breakout box contains a single professional
AES/EBU stereo digital audio input. This input is shared with the right balanced
analog input to prevent having both balanced audio and professional digital audio
connected at the same time.

The selection of audio input to capture is independent of the video input selection.
For example, even if you choose to use DV video as a source, you can still opt to use
the analog balanced inputs instead of audio embedded in the DV stream.

9 Model -02 has S/P-DIF optical and RCA inputs. Model -03 has S/P-DIF
RCA input.
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Chapter 3 - Installing the Software -
Windows 2000

The Windows NT 4.0 Osprey drivers do not work with Windows 2000. If
your Osprey card(s) were installed under the Windows NT 4.0 operating
system and the PC has now been upgraded to Windows 2000, you need to
install the Windows 2000 drivers.

Please note:
¢ Administrative privileges are required for installation.

+ Before installing software, check the Osprey Video support website
or the ftp site for the any driver update releases subsequent to the
software shipped on your CD. For the Osprey Video support

& website, go to http://www.ospreyvideo.com/> Downloads >
Software & Drivers > select Win2000 and Osprey-500 from the
table. To reach the ViewCast.com ftp site, go to
ftp:/ /ftp.ospreyvideo.com/pub/OSP-500/win2000/latest.
It's a good idea to check these sites periodically for update
releases.

¢ The screens used to illustrate the installation steps may not be
exactly what displays on your computer screen. In some cases,
version numbers and other minor differences may display in the
installation you are running.

Basics: Installing From CD
Basics: Downloading and Installing Updated Drivers
Canceling Out of the Found New Hardware Wizard
Two Install Scenarios
Scenario 1: Osprey Card(s) not Physically Installed in the PC

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software
not Installed

Testing the Installation

Uninstalling the Software
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Basics: Installing From CD

If necessary, follow the directions in Chapter 2 - Osprey-500 Hardware to install
the Osprey card. This software installation procedure works properly only if the card
is already installed.

1.

Turn on the machine and start Windows 2000.
Cancel out of the Found New Hardware wizard.

If you are updating from a previous version of the driver, it is necessary to
uninstall the old driver before installing the new driver. Please refer to
Uninstalling the Software for instructions.

Insert the Osprey-500 Driver CD into your CDROM drive. The installation
instructions assume this is the (D:) drive. Substitute the proper drive as it is
configured on your system, if necessary.

Run the installation program
a. Click the Start button

b. Click Run
c. Enter D:\Win2000\Setup in the dialog box
d. Click OK

The installation program steps are self-explanatory for many users. If you need
additional information, please refer to the section entitled Option A: Run the
Installation Program (Recommended).

The driver and demo program are ready for use as soon as the installation
program completes and you have rebooted the system. We suggest that you
test the driver immediately. Please refer to Testing the Installation for
Windows 2000.

Basics: Downloading and Installing
Updated Drivers

1.

The latest software drivers for Osprey-500 Capture Cards are available via FTP
(file transfer protocol) at the following locations:

ftp:/ /ftp.ospreyvideo.com/pub/OSP-500/win2000/latest

The same driver is used for the Osprey-500 PRO, Osprey-500 DV, and Osprey-
500 DV PRO, so these links point to the same download file. There are also
links to the drivers from our web site at http://www.ospreyvideo.com.

It is necessary to uninstall your existing Osprey-500 driver before installing a
newer version of the driver. Follow the instructions in Uninstalling the Software
and restart your computer before beginning the new install procedure.
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Use your web browser, such as Microsoft Internet Explorer or Netscape
Navigator, to find our FTP site and download the file. Type the FTP address
shown above into the address box at the top of your browser window. You may
find it simpler to type just the first part of the address -

ftp:/ /ftp.ospreyvideo.com/ - and then click on the list of directories that
display until you reach the win2000/latest location. Refer to your browser’s
help files for more specific and detailed assistance.

Download the web package file in win2000/latest to your hard disk.

The Found New Hardware wizard displays detecting each Osprey-500 card in
the computer. Follow the directions in Canceling Out of the Found New
Hardware Wizard at each prompt.

Run the web package program:
a. Click the Start button.
b. Click Run.

c. Enter <pathname> in the dialog box, where <pathname> is the location
and name of the file that you have downloaded.

d. Click OK.
The program prompts for a temporary location for unpacking the install
files.

f. See Option A: Run the Installation Program (Recommended) for a full
description of the Installation Program steps.

These files are not automatically deleted after setup has run. This feature
exists to offer the option of performing the manual Plug and Play install
later. If you want to conserve disk space, make a note of where these
files are being unpacked, and delete them after the install.

Canceling Out of the Found New Hardware Wizard

When installing an updated Osprey-500 driver, first uninstall the existing driver and
reboot the computer. The Found New Hardware wizard runs after rebooting. To
cancel out the Found New Hardware wizard:

The Digital Signature Not Found window displays for the Osprey-500 video
capture device.

Digital Signature Not Found i x|

The Microzoft digital signature affirms that software has
been tested with ‘Windows and that the software has not
been altered since it was tested.

The zoftware pou are about to inztall does not contain a
Microzaoft digital signature. Therefore, there iz ho
guarantes that this zoftware warks correctly with
windows,

Osprey-500Yideo Capture Device

I wou want ta search for Microzoft digitally signed
softweare, visit the Windows Update “Web site at
http: £ windowsupdate. microzoft. com to zee if one is
available.

Do pou want to continue the installation?

No Mare Info
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1. Click No.
The Completing Found New Hardware wizard window displays.

Found New Hardware Wizard

Completing the Found Mew Hardware 'wizard

%

\€|’: Fultimedia Videa Contraller
=

An ermor occurmed during the installation of the device

The form specified for the zubject iz not one supported or
krown by the specified trust provider.

To close this wizard, click Finish.

< Back Cancel |

2. Click Finish.

The Digital Signature Not Found window displays for the Osprey-500 audio
capture device.

Digital Signature Not Found L 5‘

The Microzoft digital signature affirmz that zoftware has
been tested with ‘Windows and that the software has not
been altered since it was tested.

The zoftware pou are about to inztall does not contain a
Microzoft digital signature. Therefore, there iz no
guarantee that this softbware works correctly with
Windows,

Ogprey-500 Audio Capture Device

If you want ta search for Microzoft digitally signed
softweare, visit the Windows Update “Web site at
http: £ windowsupdate. microzoft. com to zee if one is
available.

Do pou want to continue the installation?

No Mare Info
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3. Click No.
The Completing Found New Hardware wizard window displays.

Found New Hardware Wizard

Completing the Found Mew Hardware 'wizard
\EI’_ Fultimedia Controller

An ermor occurmed during the installation of the device

The form specified for the zubject iz not one supported or
krown by the specified trust provider.

To close this wizard, click Finish.

4, Click Finish.

Two Install Scenarios

There are two installation scenarios that might apply:

¢ Scenario 1: Osprey Card(s) not Physically Installed in the PC

¢ Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software
not Installed

In all cases, the most efficient and complete installation method is to run the
setup.exe program on the product CD or in the web package that you downloaded.
The setup program automates the Plug and Play steps required to install the drivers
and ensures that they are performed correctly. It also installs the bundled applets
and User's Guide. If you have multiple Osprey capture cards in the system, it
configures all of the boards at the same time.

Osprey driver version to another. Just run the setup.exe file to install all

® You can skip the detailed instructions if you are upgrading from one
the updated components.
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Scenario 1: Osprey Card(s) not Physically Installed in the PC

This Pre-install Scenario is the method that we recommend if you are installing an
Osprey card for the first time on a system and the Osprey software has not yet been
installed. After the install is run and as soon as an Osprey card is installed in the PC,
the card is detected and its drivers are started automatically.

Using Windows Explorer, locate and access the CD-ROM drive containing the Osprey
Installation CD-ROM.

1. Navigate to the WIN200O directory.
2. Double-click SETUP.EXE.
The Osprey-500 Video and Audio Capture Driver window displays.

¥iewCast Corporation - Osprey ¥ideo Division 5[

O sprey-500

Thiz program will inzstall the Osprep-500 for Windows 2000
#BE Computers, Version 2.2.0 build 0.

Cancel

3. Click Next.
The Information window displays.

YiewCast Corporation - Dsprey Yideo Division

Information

Pleaze read the following text.

Yo cah view this info later by opening the Readie file.

-
Oszprey Yideo Divizion ﬂ
iewCast Corporation

Osprey-600 Capture Driver
For windows 2000
Yersion 2.2.0 Build 557
5/20/2002

Sections in this file:

- Introduction A
4| | E

InstallShield

< Back Cancel |
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4. Click Next.
The Software License Agreement window displays.

¥iewCast Corporation - Osprey ¥ideo Division

License Agreement

Pleaze read the following license agreement carefully.

Press the PAGE DOWHN key to see the rest of the agreement.

EMD-USER LICENSE AGREEMENT FOR VIEWCAST.COM il

IMPORTAMT, READ CAREFULLY. This WiewCast.com End-User License Agreement

[ELILA)

iz a legal agreement between you [either az an individual or a zingle entity or

corporate entity] and YiewCast.com, Inc.., for the software product identified

above, which includes computer software and associated media and printed

materials [if any). and may include online or electronic documentation [SOFTWARE
PRODUCT or SOFTWARE). By instaling, copying, or otherwise using the SOFTWARE
FRODUCT. you agree to be bound by the terms of the ELLA. If you do not agree to ;I

Do you accept all the terms of the preceding License Agreement? |f you choose Mo, the
setup will cloze. Toinstall the Ozprey-500, pou must accept this agreement.

Irstall5Hield

< Back Yes Mo |

5. Click Yes to accept the End User Software License Agreement. If you do not
wish to accept the agreement, click No to terminate the installation routine.

The Setup Components window displays.

Select Components x|

Please choose the signal format which you want to set as the
default.

" PAL-BOHGI [Euape]

InztallShield

< Back I Mest > I Cancel |

6. Click to select the Video Standard to set as default for your Opsrey-500 card.
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7. Click Next.
The Choose Destination Location window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Choose Destination Location

Select folder where Setup will install files.

Setup will inztall the Osprey-500 in the fallowing Folder.

Tainstall to this folder, click Nest. Toinstall to a different folder, click Browse and select
anather folder.

" Destination Falder

C:\Program FileshOsprep-500 Browse... |

Irstall5Hield

< Back

Cancel |

8. If you wish to change the destination location for the files, click Browse. Click
Next.

The Select Program Folder window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Select Program Folder

Pleaze select a program folder.

Setup will add program icons to the Program Folder listed below. *'ou may tupe a new folder
name, or zelect one from the existing folders list. Click Mest ta continue.

Program Folders:

Development Kits
Startup

IrstallSHield

< Back | Mest > I Cancel
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9. If you wish to change the program folder, type the new name in the Program
Folders field. Click Next.

The Start Copying Files window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Start Copying Files
Feview zettings before copying files.

Setup has enough information to start copying the program files. |f you want to review or
change any zettings, click Back. |f you are zatizfied with the settings, click MNest to begin
copying files.

Current Settings:

Destination Directon,: ;l
C:\Pragrar Files\0zprey-500

Program Folder:
Osprey-500

L o

InstallShield

Cancel |

10. If there are any settings to be changed prior to installation, click Back to return
to the previous windows. Click Next.

A question dialog window displays.

There is no Osprey Card{s) Installed on you 1'

@ Do you Want to Pre-install the Osprey-500 Drivers Anyiway?

11. Click Yes to continue the installation process.

The Digital Signature Not Found window displays for the video portion of the
installation.

Digital Signature Mot Found x|

The Microsoft digital signature affirms that software has
been tested with Yindows and that the software has not
been altered since it was tested.

The zoftware you are about ta inztall does not contain a
Microzoft digital signature. Therefore, there is no
guarantee that this software waorks correctly with
Windows.

Unknown software package

If you want ta search for Microzoft digitally signed
software, visit the Windows Update Web site at
http: £ Awindowsupdate. microzoft. com ta zee if one is
available.

Do you want to continue the installation?

No Mare Info
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12. Click Yes to continue with the installation process.
A Question Dialog window displays.

There is no Osprey Card{s) Installed on your System 5[

@ Do you wank ko replace your current 1420 codec with WiewCast's 1420 codec?

13. Click Yes.
A Question Dialog window displays.
b
@ Do you wank to replace your current YUYZ2 codec with WiewCast's YUYZ codec?
mo |
14. Click Yes.

The Osprey Video Division Special Offers Shortcuts window displays.

YiewCast Corporation - Osprey ¥ideo Division

15. Click Yes to place the shortcut on your desktop. If you do not want the
shortcut on your desktop, click No.

The Product Registration question window displays.

PRODUCT REGISTRATION 1'

@ WWould wou like to register the Osprey 5007
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16. Click Yes to open a web browser window and register your Osprey-500 card at
the Osprey Video website (http://www.ospreyvideo.com/). Click No if you
would like to register your Osprey-500 card later.

The Setup Complete window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Setup Complete

The Ozprey-500 program group containg icons for the
WidCap32 sample applet and for the ReadMe. ou will need ta
restart the machine before using the Osprey-500.

@ Fes | want to restart my computer now

€ Mo, | will restart my computer later.

Femove any disks from their drives, and then click Finish to
complete setup.

< Back | Finish I

17. Click to select No.
18. Click Finish to complete the installation.

If you are not installing the Osprey card at this time, click No then Finish to
proceed. When you start your computer after installing the Osprey hardware, the
Found New Hardware Wizard runs upon detecting new hardware. The sequence
of windows are similar to that in Appendix H - Adding/Moving Boards in
Windows 2000.

The Osprey card does not need to be installed at this time. You also do
not need to restart the computer at this time.
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After you have installed the Osprey-500 card into your system, this
sequence of windows displays:

When Windows detects the new card, a Found New Hardware window for the
Multimedia Video Controller briefly displays on your screen, then the Digital
Signature Not Found window displays.

Found New Hardware

\@’__, Ozprey-600 Yideo Capture Device

=
-

Installing ...

Digital Signature Mot Found x|

The Microzoft digital signature affirms that software has
been tested with Windows and that the software has not
been altered since it was tested.

The zoftware you are about ta inztall does not contain a
Microzoft digital signature. Therefore, there is no
guarantee that this software works correctly with
Windows.

Osprey-500Yideo Capture Device

If you want to search for Microzoft digitally signed
zoftware, visit the Windows Update Web site at
http: /Awindowsupdate. microzoft. com ta see if one iz
available.

Do you want to continue the installation?

Hao More Info

1. Click Yes to continue.
A Files Needed window displays.

Files Needed

The file 'o500dr. sys' on Osprey-500 Driver Installation
= Mediais nesded

Cancel

Type the path where the fils is located, and then click
(]

LCopy files from:

Browse... |

2. Click Browse to locate the directory Program Files\Osprey-500\driver.

3. Click Open.
4. Click OK.
A Copy Error window displays.

Copy Error 1'

Q Setup cannot copy the file Jedi bf. Rty |
Cancel |

Enzure that the location specified below is comrect, or
change it and inzert '0zprey-500 Driver Installation
Media' in the drive vou specify.

LCopy files from:

Cw/ MM T Saypstem32
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5. Click Browse to locate the directory Program Files\Osprey-500\driver.
Click Open.
7. Click OK.

A Found New Hardware window for the Multimedia Video Controller briefly
displays on your screen, then the Digital Signature Not Found window displays.

Found New Hardware

\@’: Multimedia Contraller

o

-
-

Please wait ...

Digital Signature Not Found x|

The Micrazoft digital signature affirms that zoftware haz
been tested with *Windows and that the software has not
been altered since it was tested.

The zoftware you are about to inztall does not contain &
Microzaft digital signature. Therefare, there iz nio
guarantee that this software warks correctly with
Windows.

Osprey-500 Audio Capture Device

If pou want to search for Microzoft digitally signed
software, visit the Windows Update “Web site at
hitp:/Awindowsupdate. microgoft. com to see if one is
available.

Do you want to continue the installation?

Mo More Info

8. Click Yes to continue.
A Files Needed window displays.

Files Needed

The file 'obca. gyg' on Osprey-500 Driver Installation oK
== Mediais needed.

Cancel

i

Type the path where the fle iz located, and then click
oK.

LCopy files from:

J

Browse..

9. Click Browse to locate the directory Program Files\Osprey-500\driver.
10. Click Open.
11. Click OK.

prompted to restart your system. The card will not function as expected

0 The Osprey-500 card installation has been completed, and you are
until after you restart your computer.
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Scenario 2: Osprey Card(s) Physically Installed, but Osprey
Software not Installed

In this case you have two options:

¢+ Option A: Run the Installation Program (Recommended)
¢+ Option B: Use the New Hardware Found Wizard (Not Recommended)

Option A: Run the Installation Program (Recommended)

When windows 2000 is started for the first time after the Osprey card is installed,
the Found New Hardware wizard displays one or more times. Cancel out of these
wizards. After Windows 2000 has finished starting, do the following:

To install the Osprey drivers:

1. Using Windows Explorer, locate and access the CD-ROM drive containing the
Osprey Installation CD-ROM.

2. Navigate to the WIN2000O directory.
3. Double-click SETUP.EXE.
The Osprey-500 Video and Audio Capture Driver window displays.

¥iewCast Corporation - Osprey ¥ideo Division 5'

D sprey-500

Thiz program will install the Osprep-500 for Windows 2000
#BE Computers, Version 2.2.0 build 0.

Cancel |
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4. Click Next.
The Information window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Information

Pleaze read the following text.

You can view this info later by opening the ReadMe file.

-
Dsprey Yideo Divizion :I
iewCast Corporation

Osprey-500 Capture Diriver
For %indows 2000
Version 2.2.0 Build 557
5/20/2002

Sections in this file:

- Introduction v
« | »

Irstall5Hield

< Back

Cancel |

5. Click Next.
The Software License Agreement window displays.

¥iewCast Corporation - Osprey ¥ideo Division

License Agreement

Fleasze read the following license agreement carefully.

Press the PAGE DOWHN key to see the rest of the agreement.

EMD-USER LICEMSE AGREEMEMNT FOR WIEWCAST.COM ﬁl
IMPORTAMNT, READ CAREFULLY. This ViewCast.com End-User License Agreement
[EUL&)

iz a legal agreement between you [either az an individual or a single entity or

corporate entity] and YiswCast.com, Inc.., for the software product identified

above, which includes computer software and associated media and printed

materialz (if any), and may include online or electronic documentation [SOFTWARE
PRODUCT ar SOFTWARE). By instaling. copying. or otherwize uzsing the SOFTWARE
PRODUCT. you agree to be bound by the terms of the ELLA. If you do not agree to LI

D you accept all the terms of the preceding License Agreement? |f you choose Ma, the
setup will cloze. To inztall the Ozprey-500, pou must accept this agreement.

ImstallShield

< Back Yes No
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6. Click Yes to accept the End User Software License Agreement. If you do not
wish to accept the agreement, click No to terminate the installation routine.
The Setup Components window displays.
¥iewCast Corporation - Osprey ¥ideo Division
Setup Type
Choosge the setup tupe that best suitz your needs.
Please choose the signal format which vou want to set az the default.
al
" PAL-BOHGI [Eurape]
InstallShield
< Back | Mest » I Cancel |
7.  Click to select the Video Standard to set as default for your Opsrey-500 card.
8. Click Next.
The Choose Destination Location window displays.
¥iewCast Corporation - Osprey ¥ideo Division
Choose Destination Location
Select folder where Setup will install files.
Setup will inztall the Osprey-500 in the fallowing Falder.
Tainztall ta this folder, click Next. Tainstall to a different folder, click Browse and zelect
anather folder.
Destination Falder
’7C:\Program Files 0 gprey-500 Browse... |
IrstallSHield
< Back Cancel |
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9. If you wish to change the destination location for the files, click Browse. Click
Next.

The Select Program Folder window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Select Program Folder
Fleaze select a program folder.

Setup will add program icons to the Program Folder listed below. *r'ou may tvpe a new folder
name, or zelect one from the existing folders list. Click Mest to continue.

Program Folders:

Exigting Folders:
A e
Administrative Tools
Development Kits
Startup

InstallShield

< Back | Mest » I Cancel |

10. If you wish to change the program folder, type the new name in the Program
Folders field. Click Next.

The Start Copying Files window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Start Copying Files
Feview settings before copying files.

Setup has enough information to start copying the program files, |f you want to review or
change any settings, click Back. |f you are satizfied with the settings, click Next to begin
copying files.

Current Settings:

Destination Directon: ;l
C:\Program Files\Ogprey-500

Program Folder:
Osprey-500

H o

ImstallShield

Cancel |
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11. If there are any settings to be changed prior to installation, click Back to return
to the previous windows. Click Next.

The Digital Signature Not Found window displays.

Digital Signature Not Found x|

The Microzoft digital signature affirms that software has
been tested with \Windows and that the software has not
been altered since it was tested.

The software vou are about ta install does not contain a
Microzoft digital signature. Therefore, there is no
guarantee that this eoftware works cormecty with
Windows.

Osgprey-500 Yideo Capture Device

If wau want ta search far Microzoft digitally signed
software, visit the "Windaows Update 'web site at
http: //windowsupdate. microsoft. com to see if one is
available.

Do pou want to continue the installation?

No | More Info |

500 card in the computer. Windows 2000 recognizes the audio and video

i The Digital Signature Not Found window displays twice for each Osprey-
portions of the Osprey cards as separate items.

12. Click Yes to continue with the installation process.
A Question Dialog window displays.

There is no Osprey Card{s) Installed on your System 5'

@ Do you wank to replace your current 1420 codec with WiewCast's 1420 codec?

13. Click Yes.
A Question Dialog window displays.

There is no Osprey Card{s) Installed on your System 1[

@ Do you wank to replace your current YUYZ2 codec with WiewCast's YUYZ codec?

14. Click Yes.
The Osprey Video Division Special Offers Shortcuts window displays.

YiewCast Corporation - Dsprey ¥ideo Division

46 Osprey-500 User's Guide - Version 2.2.0



Chapter 3 - Installing the Software - Windows 2000

15.

16.

17.

Click Yes to place the shortcut on your desktop. If you do not want the
shortcut on your desktop, click No.

The Product Registration question window displays.

PRODUCT REGISTRATION ZI

@ WWould wou like to register the Osprey 5007

Click Yes to open a web browser window and register your Osprey-500 card at
the Osprey Video website (http://www.ospreyvideo.com/). Click No if you
would like to register your Osprey-500 card later.

The Setup Complete window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Setup Complete

The Ozprey-500 program group containg icons for the
WidCap32 sample applet and for the ReadMe. ou will need ta
restart the machine before using the Osprey-500.

@ Fes | want to restart my computer now

€ Mo, | will restart my computer later.

Femove any disks from their drives, and then click Finish to
complete setup.

< Back | Finish I

Click Finish to complete the installation and restart your computer. You must
restart your computer before you can use the Osprey-500 card.

Option B: Use the Found New Hardware Wizard (Not
Recommended)

This method is more complicated than Option A. It is particularly inconvenient if you
are installing multiple cards at once, since each card has to be set up separately.
This process installs only the driver and is useful only for updating the driver
component. Furthermore, to get the sample applications and other required items,
you must still run the setup.exe program detailed in Scenario 2, Option A.

a computer on which the Osprey-500 software has never previously been

i The following windows and instructions assume that you are working with

installed.
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When Windows 2000 starts, it detects the new card(s) and starts the Found New
Hardware Wizard.

Please carefully note the terminology in the Found New Hardware Wizard.

For all Osprey-500 model cards, the Wizard detects two logical devices for
each card - a Multimedia Video Controller device and a Multimedia
& Controller device.

The Multimedia Video Controller corresponds to the Osprey-500 video
device. The Multimedia Controller corresponds to the Osprey-500 audio
device.

The first window to display is the Found New Hardware Wizard.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

This wizard helps you install a device driver for a
hardware device.

To continue, click Nest.

< Back Cancel

1. Click Next.
The Welcome window displays.

Found New Hardware Wizard

Install Hardware Device Drivers o
A device driver is a software program that enables a hardware device to work with
an operating system.

Thiz wizard will complete the installation for this deviee:

@ Multimedia Videa Cantraller

A device driver iz a software program that makes a hardware device work. Windows
needs driver files for your new device. To locate diver files and complete the
installation click Mest.

‘what do pou want the wizard to do”?

* Search for a suitable driver for my device [recommendedf

" Display alist of the known drivers for this device so that | can choose a specific
driver

< Back I Mest > I Cancel

48 Osprey-500 User's Guide - Version 2.2.0



Chapter 3 - Installing the Software - Windows 2000

2. Select Search for a suitable driver and click Next.
The Locate Driver Files window displays.

Found New Hardware Wizard

Locate Driver Files P
‘where do you want Windows to search for driver files?

Search for driver files for the following hardware device:

@ Mulimedia Videa Contraller

The wizard searches for suitable drivers in itz driver databaze on your computer and in
any of the follawing optional zearch locations that vou specify.

To start the zearch, click Mext. If you are searching on a floppy disk or CD-ROM drive,
inzert the floppy disk or CD' before clicking Next.

Optional zearch locations:

[V CD-ROM diives
¥ Specify a location
[T Microsoft windows Update

< Back I Mest » I Cancel

3. Click to select Specify a location
4, Click Next.
The Found New Hardware Wizard's specify location window displays.

Found New Hardware Wizard |
Insert the manufacturer's installation disk into the drive oK. |
selected, and then click OK.

Cancel |

LCopy manufacturer's files from:

|E:NwinZ000

5. Click Browse and browse to the location of the Osprey-500 driver

9 This location is either the Win2000 directory on the CD-ROM drive, or the
location to which you downloaded the driver.
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6. Click OK.
The Driver Files Search Results window displays.

Found New Hardware Wizard

Driver Files Search Results
The wizard has finished searching for driver files for your hardware device.

The wizard found a driver for the following device:

@ Mulimedia Videa Contraller

indowes found a driver for this device. To install the driver Windows found, click Nest.

= evwin2000%a500dr. inf

< Back Cancel

7. Click Next.
The Digital Signature Not Found window displays.

Digital Signature Mot Found x|

The Microsoft digital signature affirms that software has
been tested with Yindows and that the software has not
been altered since it was tested.

The zoftware you are about ta inztall does not contain a
Microzoft digital signature. Therefore, there is no
guarantee that this software works correctly with
Windows.

Osprey-500Yideo Capture Device

If you want to search for Microzoft digitally signed
zoftware, visit the Windows Update Web site at
http: £ Awindowsupdate. microzoft. com ta zee if one is
available.

Do you want to continue the installation?

No Mare Info
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8. Click Yes.
The Completion window displays.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

_\> Ozprep-h00Video Capture Device

5

‘windows has finizhed installing the software for this device.

Ta close this wizard, click Finish.

< Back Caticel

9. Click Finish.

At this point the Osprey-500 video driver has been installed. You should
now get a new Found New Hardware popup - this time for the Multimedia

& Controller (i.e., the audio device) - and this new window is quickly
covered by a new Digital Signature Message for the Osprey-500 audio
driver.

10. Click Next.
The second Digital Signature Not Found window displays.

Digital Signature Not Found x|

The Microzoft digital signature affirms that zoftware has
been tested with "Windows and that the software has not
been altered since it was tested.

The zoftware you are about to inztall does not contain a
Micrazoft digital sighature. Therefare, there iz ho
guarantee that this software warks correctly with
indows,

Osgprey-500 Audio Capture Device

If wou want ta search for Microzoft digitally signed
softweare, visit the Windows Update “Web site at
http: /A windowszupdate. microgoft. com to zee if one is
available.

Do pou want to continue the installation?

No | Mare Info

11. Click Yes to complete the driver installation process.

If your system contains multiple Osprey-500 cards, you must restart your

& computer before you can use all of the Osprey-500 cards. However, you
do not need to restart your computer if only one Osprey-500 card is
installed.

Osprey-500 User's Guide - Version 2.2.0 51



Chapter 3 - Installing the Software - Windows 2000

This process installs only the driver and is useful only for updating the
driver component. To get the sample applications and other required
items, you must still run the setup.exe program. See Scenario 2, Option
A for those instructions.

Testing the Installation for Windows 2000

1.  Verify that the hardware installation is complete according to the directions in
Chapter 2 - Osprey-500 Hardware.

2. Connect a video signal source to one of the Osprey-500 connectors
(Composite/S-video/SDI/DV).

3. Open the Osprey-500 group in the Start menu.

4. Click the VidCap32 icon. Refer to Chapter 8 - VidCap32 for more information
on this application.

5. If your input is composite video, the screen displays a still video frame from the
Osprey-500 board. Click the Overlay button. The screen should display moving
video frames. If your input choice is not composite video, select the Video
Source option under the Options menu. This brings up the Osprey-500's video
capture driver configuration box where you can select your video input.

6. If the video area does not contain video, it could be for one of the following
reasons:

a. The driver is looking for video on the wrong input connector. You can either
move the video cable to another connector or reconfigure the driver using
its Control Dialog. Refer to Chapter 6 - Osprey-500 Video Control
Dialog.

b. The video source is not turned on or activated.

7. If the video area is scrambled or has bad color, the signal format of your video
source may be different from the signal format selected in the driver software.
Since the driver defaults to NTSC-M signal format, users of PAL equipment
always need to change the driver’s signal format the first time they run the
driver. Refer to Chapter 6 - Osprey-500 Video Control Dialog for more
information.

52 Osprey-500 User's Guide - Version 2.2.0



Chapter 3 - Installing the Software - Windows 2000

Uninstalling the Software

If you need to remove the Osprey driver from your system:

Open the Control Panel.

Double-click Add/Remove Programs.

Click to select Change or Remove Programs.

Highlight the Osprey-500 Driver entry.

Click Change/Remove in the Osprey entry.

The uninstall program begins.

Click Yes to proceed.

Click OK when the process is complete.

8. Please reboot your computer to finish removing the driver.

iAW e

N o
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Chapter 4 - Installing the Software -
Windows XP

The Windows NT 4.0 Osprey drivers do not work with Windows XP. If your
Osprey card(s) were installed under the Windows NT 4.0 operating
system and the PC has now been upgraded to Windows XP, you need to
install the Windows XP drivers.

Please note:
¢ Administrative privileges are required for installation.

+ Before installing software, check the ViewCast.com support
website or the ftp site for the any driver update releases
subsequent to the software shipped on your CD. For the

& ViewCast.com support website, go to
http://www.ospreyvideo.com/> Downloads > Software &
Drivers > select WinXP and Osprey-500 from the table. To reach
the ViewCast.com ftp site, go to
ftp:/ /ftp.ospreyvideo.com/pub/OSP-500/winXP/latest. It's
a good idea to check these sites periodically for update releases.

¢ The screens used to illustrate the installation steps may not be
exactly what displays on your computer screen. In some cases,
version numbers and other minor differences may display in the
installation you are running.

Basics: Installing From CD
Basics: Downloading and Installing Updated Drivers
Canceling Out of the Found New Hardware Wizard
Two Install Scenarios
Scenario 1: Osprey Card(s) not Physically Installed in the PC

Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software
not Installed

Testing the Installation

Uninstalling the Software
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Basics: Installing From CD

If necessary, follow the directions in Chapter 2 - Osprey-500 Hardware to install
the Osprey card. This software installation procedure works properly only if the card
is already installed.

1.

Turn on the machine and start Windows XP.
Cancel out of the Found New Hardware wizard.

If you are updating from a previous version of the driver, it is necessary to
uninstall the old driver before installing the new driver. Please refer to
Uninstalling the Software for instructions.

Insert the Osprey-500 Driver CD into your CDROM drive. The installation
instructions assume this is the (D:) drive. Substitute the proper drive as it is
configured on your system, if necessary.

Run the installation program

a. Click the Start button

b. Click Run
c. Enter D:\WinXP\Setup in the dialog box
d. Click OK

The installation program steps are self-explanatory for many users. If you need
additional information, please refer to the section entitled Option A: Run the
Installation Program (Recommended).

The driver and demo program are ready for use as soon as the installation
program completes and you have rebooted the system. We suggest that you
test the driver immediately. Please refer to Testing the Installation for
Windows XP.

Basics: Downloading and Installing
Updated Drivers

The latest software drivers for Osprey-500 Capture Cards are available via FTP
(file transfer protocol) at the following locations:

ftp:/ /ftp.ospreyvideo.com/pub/OSP-500/winXP/latest

The same driver is used for the Osprey-500 PRO, Osprey-500 DV, and Osprey-
500 DV PRO, so these links point to the same download file. There are also
links to the drivers from our web site at http://www.ospreyvideo.com.

It is necessary to uninstall your existing Osprey-500 driver before installing a
newer version of the driver. Follow the instructions in Uninstalling the Software
and restart your computer before beginning the new install procedure.
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3. Use your web browser, such as Microsoft Internet Explorer or Netscape
Navigator, to find our FTP site and download the file. Type the FTP address
shown above into the address box at the top of your browser window. You may
find it simpler to type just the first part of the address -
ftp:/ /ftp.ospreyvideo.com/- and then click on the list of directories that
display until you reach the winXP/latest location. Refer to your browser’s help
files for more specific and detailed assistance.

4, Download the web package file in winXP/latest to your hard disk.

5. The Found New Hardware wizard displays detecting each Osprey-500 card in
the computer. Follow the directions in Canceling Out of the Found New
Hardware Wizard at each prompt.

6. Run the web package program:
a. Click the Start button.
b. Click Run.

c. Enter <pathname> in the dialog box, where <pathname> is the location
and name of the file that you have downloaded.

d. Click OK.

The program prompts for a temporary location for unpacking the install
files.

f. See Option A: Run the Installation Program (Recommended) for a full
description of the Installation Program steps.

These files are not automatically deleted after setup has run. This feature
exists to offer the option of performing the manual Plug and Play install
later. If you want to conserve disk space, make a note of where these
files are being unpacked, and delete them after the install.
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Canceling Out of the Found New Hardware Wizard

When installing an updated Osprey-500 driver, first uninstall the existing driver and
reboot the computer. The Found New Hardware wizard runs after rebooting. To
cancel out the Found New Hardware wizard:

The Digital Signature Not Found window displays for the Osprey-500 video
capture device.

Found New Hardware Wizard

Welcome to the Found New

:l?\ Hardware Wizard

Thiz wizard helps you install software far:

Multimedia ideo Controller

'j If your hardware came with an installation CD
~1i=2 or floppy disk. insert it now.

‘what do pou want the wizard to do?

@ {nstall the software automatically (F ecormmended]

€ Install from a list or specific location [Advanced)

Click Mest to continue.

< Back I Mest » I Cancel

1. Click Cancel.
The Found New Hardware Wizard window displays.

Found New Hardware Wizard

Welcome to the Found New
N\ Hardware Wizard

This wizard helps you install software for:

Multimedia Cantroller

'j If your hardware came with an installation CD
~12 or floppy disk. insert it now.

‘what do pou want the wizand to do?

@ {nstall the software automatically (F ecormmended]

" Inztall from a list or specific location [Advanced)

Click Mest to continue.

< Back I Mext » I Cancel

2. Click Cancel to exit the Found New Hardware Wizard.
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Two Install Scenarios

There are two installation scenarios that might apply:

¢ Scenario 1: Osprey Card(s) not Physically Installed in the PC

¢ Scenario 2: Osprey Card(s) Physically Installed, but Osprey Software
not Installed

In all cases, the most efficient and complete installation method is to run the
setup.exe program on the product CD or in the web package that you downloaded.
The setup program automates the Plug and Play steps required to install the drivers
and ensures that they are performed correctly. It also installs the bundled applets
and User's Guide. If you have multiple Osprey capture cards in the system, it
configures all of the boards at the same time.

Osprey driver version to another. Just run the setup.exe file to install all

® You can skip the detailed instructions if you are upgrading from one
the updated components.

Scenario 1: Osprey Card(s) not Physically Installed in the PC

This Pre-install Scenario is the method that we recommend if you are installing an
Osprey card for the first time on a system and the Osprey software has not yet been
installed. After the install is run and as soon as an Osprey card is installed in the PC,
the card is detected and its drivers are started automatically.

Using Windows Explorer, locate and access the CD-ROM drive containing the Osprey
Installation CD-ROM.
1. Navigate to the WINXP directory.

Double-click SETUP.EXE.

The Osprey-500 Video and Audio Capture Driver window displays.

¥iewCast Corporation - Osprey ¥ideo Division 5[

Dszprey-500

This program will install the Ozprep-B00 for Windows XP
#8E Computers, Version 2.2.0 build 557.

Cancel
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3. Click Next.
The Information window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Information
Pleaze read the following text.

Y'ou can view this info later by opening the ReadMe file.

Ozprey Video Division
WiewCast Corporation

Osgprey-500 Capture Crriver

For Windows =P
‘ersion 2. 2.0 Build 505
5/13/2002

Sections in this file:
- Introduction

|

IrstallShield

< Back

4. Click Next.
The Software License Agreement window displays.

YiewCast Corporation - Osprey ¥ideo Division

License Agreement

Pleasze read the fallowing licenze agreement carefully.

Prezs the PAGE DOWN key to zee the rest of the agreement.

END-USER LICENSE AGREEMEMT FOR WIEWCAST.COM

IMPORTANT, READ CAREFULLY. This YiewCast.com End-User License Agreement
[ELILA)

iz a legal agreement bebween vou [either as an individual or a single entity or

corporate entity] and YiewCast.com, Inc., for the software product identified

above, which includes computer software and associated media and printed

materials (if any]. and may include online ar electronic documentation [SOFTWARE
PRODUCT ar SOFTWARE). By instaling. copying, or otherwise uzing the SOFTWARE
FRODUCT. you agree ta be bound by the terms of the EULA. If you do not agree to

Do you accept all the terms of the preceding License Agreement? |f you choose Ma, the
setup will close. Toinstall the Osprey-500, you must accept this agreement.

IristallShield

B

=]

< Back Yes No
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5. Click Yes to accept the End User Software License Agreement. If you do not
wish to accept the agreement, click No to terminate the installation routine.

The Setup Type window displays.

YiewCast Corporation - Osprey ¥ideo Division

Setup Type

Choose the zetup tupe that best suits your needs.

Please choose the signal format which pou want ta set as the default

" NTSC [Morth America)
o .

IristallShield

< Back | Mest » I Cancel

6. Click Next.
The Choose Destination Location window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Choose Destination Location
Select folder where Setup will install files.

Setup will install the Osprey-500 in the following folder.

Ta inztall b this folder, click Nest. Ta install to a different folder, click Browse and select
anather folder.

C:vProgram Files\Osprep-500 Browse... |

IristallShield

" D estination Folder

Cancel |
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7. Click Next.
The Select Program Folder window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Select Program Folder
Pleaze select a program folder.

Setup will add program icons to the Program Folder listed below. “You may type a new folder
hame, or select one from the existing folders list. Click Mext to continue.

Program Folders:

E sisting Folders:

Real -
Fowxio Eazy CD Creator & _I
SimulStream Application

Sorenzon

Startup

Support Keph aker

Symantec Ghost

Windows Media

Winip ™

InstallShield

< Back | Mest » I Cancel

8. Click Next.
The Start Copying Files window displays.

YiewCast Corporation - Osprey ¥ideo Division

Start Copying Files

Review zettings before copying files.

Setup haz enaugh infarmation ko start copying the program filez. |f pou want ta review ar
change any settings, click Back. If you are satisfied with the settings., click Mext to begin
copying files.

Current Seftings:

Destination Directary: ;I
C:\Program Files\0sprey-500

Frogram Folder:
Osprey-500

L o

IristallShield

< Back

9. Click Next.
A question window displays.

There is no Osprey Card(s) Installed on your System |z|

9

\_.{) Do you Want ko Pre-install the Osprey-500 Drivers Anyinay?

62 Osprey-500 User's Guide - Version 2.2.0



Chapter 4 - Installing the Software - Windows XP

10. Click Yes to continue the installation process. Skip to step 11 if installing POST-WHQL version.
The Software Installation window displays.

Software Installation

] E The software you are instaling has not passed Windows Logo
L} testing to verify its compatibility with Windows #<P. [Tell me why
this testing ig important. ]

Continuing your installation of this soft may impair
or destabilize the comrect operation of your system
either iImmediately or in the future. Microzoft strongly
recommends that you stop this installation now and
contact the software yendor for software that has
passed Windows Logo testing.

Continue Aryway ] [ STOP Installation |

11. Click Continue Anyway.
A question window displays.

There is no Osprey Card(s) Installed on your System

\_?X Do you wank to replace your current 1420 codec with WiewCast's 1420 codec?

12. Click Yes.
A question window displays.

There is no Osprey Card(s) Installed on your System

13. Click Yes.
A question window displays.

ViewCast Corporation, - Osprey Video Division Shortcut

P would vou like a deskhop icon installed For excusive special offers From YiewCast
\-‘/ Corporation - Osprey Video Division?

Osprey-500 User's Guide - Version 2.2.0 63



Chapter 4 - Installing the Software - Windows XP

14. Click Yes to place the shortcut on your desktop. If you do not want the
shortcut on your desktop, click No.

The Setup Complete window displays.

Setup Complete

The Ogprey-500 program group containg icong for the WidCapa2
zample applet and for the Readie.

*r'ou will need to restart the machine before using the
Ogprey-500.

+ es, | warl to restart my computer nov.

" Mo, | will restart my computer later.

Femove any disks from their drives, and then click Finish to
complete setup.

| Finizh |

If you are not installing the Osprey card at this time, click No then Finish to
proceed. When you start your computer after installing the Osprey hardware, the
Found New Hardware Wizard runs upon detecting new hardware. The sequence
of windows are similar to that in Appendix H - Adding/Moving Boards in
Windows 2000.

The Osprey card does not need to be installed at this time. You also do
not need to restart the computer at this time.

Scenario 2: Osprey Card(s) Physically Installed, but Osprey
Software not Installed

In this case you have two options:

+ Option A: Run the Installation Program (Recommended)
+ Option B: Use the Found New Hardware Wizard (Not Recommended)
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Option A: Run the Installation Program (Recommended)

When Windows XP is started for the first time after the Osprey card is installed, the
Found New Hardware wizard displays one or more times. Cancel out of these
wizards. After Windows XP has finished starting, do the following:

To install the Osprey drivers:

1. Navigate to the WINXP directory.
2. Double-click SETUP.EXE.
The Osprey-500 Video and Audio Capture Driver window displays.

¥iewCast Corporation - Osprey ¥ideo Division 5[

DOszprey-500

This program will install the Ozprey-500 for Windows %P
#BE Computers, Version 2.2.0 build 557

Cancel

3. Click Next.
The Information window displays.

YiewCast Corporation - Dsprey Yideo Division

Information

Please read the following text.

You can view thiz info later by opening the ReadMe file.

-
Osprey Yideo Divizion ﬂ
WiewCast Corporation

Osprey-500 Capture Diriver
For windows =P

Wersion 2.2.0 Build 505
541342002

Sections in this file:

- Introduction A
4 | E

IristallShield

Cancel |
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4. Click Next.
The Software License Agreement window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Licenze Agreement

Pleaze read the following licensze agreement carefully.

Press the PAGE DOWN key to see the rest of the agreement.

EMND-USER LICEMSE AGREEMEMNT FOR WIEWCAST.COM
IMPORTANT, READ CAREFULLY. This YiewCast.com End-Uszer License Agreement
[ELILA)

iz a legal agreement bebween vou [either as an individual or a single entity or

corporate entity] and YiewCast.com, Inc., for the software product identified

above, which includes computer software and associated media and printed

materials (if any]. and may include online or electronic docurnentation [SOFTWARE
PRODUCT ar SOFTWARE). By installing. copying. or otherwize uzing the SOFTWARE
PRODUCT. you agree ta be bound by the terms of the EULA. If you do not agree to

=l
Do you accept all the termz of the preceding License Agreement? If you choose Mo, the
setup will close. Toinstall the Osprey-500, you must accept this agreement.
IrstallShield
< Back Yes No

5. Click Yes to accept the End User Software License Agreement. If you do not
wish to accept the agreement, click No to terminate the installation routine.

The Setup Type window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Setup Type

Chooze the setup tupe that best suits your needs.

Please choose the signal format which pou want to set as the default,

 NTSE [MNorth America)

IristallShield

< Back | Mest » I Cancel
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6. Click Next.
The Choose Destination Location window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Choose Destination Location
Select folder where Setup will install files.

Setup will install the Osprey-500 in the following folder.

Ta inztall b this folder, click Nest. Ta install to a different folder, click Browse and select
anather folder.

Destination Folder
’7E:\Pr0gram Filesh0zprep-500 Browse... |
IstallShield

< Back Cancel |

7. Click Next.
The Select Program Folder window displays.

YiewCast Corporation - Osprey ¥ideo Division

Select Program Folder

Pleasze zelect a program folder.

Setup will add prograrm icons to the Program Folder listed below. “You may twpe a new folder
name, or select one from the existing folders list. Click Mext ta continue.

Program Folders:
11}

E zisting Folders:

Feal |

Rowio Easy CD Creator &

SimulStream &pplication

Sorerson

Startup

Support Kephd aker

Symantec Ghaost

Wwindows Media

WinZip hd

IristallShield

< Back | Mest > I Cancel
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8. Click Next.
The Start Copying Files window displays.

¥iewCast Corporation - Osprey ¥ideo Division

Start Copying Files
Feview zettiings before copying files.

Setup haz enough information to start copying the program files. |f you want to review or
change any zettings, click Back. If you are satisfied with the settings., click Mext to begin
copying files.

Curmrent Seftings:

Destination Directon: ;l
C:\Program Filez\O zprey-500
Frogram Folder:
Osprey-500
Kl |
IstallShield

Cancel |

9. Click Next. Skip to Step 10 if you are installing the POST-WHQL driver version.
The Software Installation window displays.

Software Installation

] E The zoftware you are instaling has not pazzed Windows Logo
Lt testing ta verify itz compatibility with Windows <P, [Tell me why
this testing iz important.]

Continuing your installation of thiz software may impair
or destabilize the comrect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the software vendor for software that has
passed Windows Logo testing.

LContinue Argveay ] | STOF Installation

10. Click Continue Anyway.
A question window displays.

Question

\_?/ Do wou want ko replace your current 1420 codec with YiewCast's 1420 codec?

11. Click Yes.
A question window displays.

Question

68 Osprey-500 User's Guide - Version 2.2.0



Chapter 4 - Installing the Software - Windows XP

12. Click Yes.
A question window displays.

ViewCast Corporation, - Osprey Video Division Shortcut

9 Would you like a desktop icon installed For exclusive special offers From YiewCast
x‘/ Corporation - Osprey Video Division?

13. Click Yes to place the shortcut on your desktop. If you do not want the
shortcut on your desktop, click No.

The Product Registration window displays.

PRODUCT REGISTRATION 1'

“_?/ ‘Whould vou like ko register the Osprey 5007

14. Click Yes to open a web browser window and register your Osprey-500 card at
the Osprey Video website. Click No if you would like to register your Osprey-
500 card later.

The Setup Complete window displays.

9 The installation continues after you close the browser window.

¥iewCast Corporation - Osprey ¥ideo Division

Setup Complete

The Ozprey-500 program group contains icons for the
WidCap32 sample applet and for the ReadMe. You will need to
restart the machine before using the Osprey-500.

% Hes, | want to restart my computer now.

7 Mo, | will restart my computer later.

Remave any disks from their drives, and then click Finish to
conmplete setup.

< Back | Finish I
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Option B: Use the Found New Hardware Wizard (Not
Recommended)

This method is more complicated than Option A. It is particularly inconvenient if you
are installing multiple cards at once, since each card has to be set up separately.
This process installs only the driver and is useful only for updating the driver
component. Furthermore, to get the sample applications and other required items,
you must still run the setup.exe program detailed in Scenario 2, Option A.

a computer on which the Osprey-500 software has never previously been

i The following windows and instructions assume that you are working with
installed.

When Windows XP starts, it detects the new card(s) and starts the Found New
Hardware Wizard.

Please carefully note the terminology in the Found New Hardware Wizard.

For all Bt/Ct878-based Osprey cards, the Wizard detects two logical
devices for each card - a Multimedia Video Controller device and a
& Multimedia Controller device.

The Multimedia Video Controller corresponds to the Osprey-500 video
device. The Multimedia Controller corresponds to the Osprey-500 audio
device.

The first window to display is the Found New Hardware Wizard.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps you install software far:

Osprey-500 Video Capture Device

\'j If your hardware came with an installation CD
~a2 or floppy disk. insert it now.

‘what do pou want the wizard to do?

(2 |nstall the software automatically [Fecommended)

Click Mest to continue.

l MNest » ][ Cancel
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1. Click to select Install from a list or specific location.
2. Click Next.
The Found New Hardware Wizard window displays.

Found New Hardware Wizard

Please choose your h and installati plions. .5

(%) Search for the best diver in thess locations.,

Usge the check boxes below ta limit or expand the default search, which includes local
paths and removable media. The best driver found will be installed.

Search removable media [floppy, CO-ROM..)
Inelude thiz location in the search:

E:NwfinsP w| [ Bromse |

(O Don't zearch. | will chooze the driver to install

Choose thiz option to select the device driver fram a list. “Windows does not guarantee that
the driver you choose will be the best match for your hardware.

[ < Back ][ Mest » ][ Cancel ]

3. Click to select Search. Click Browse to locate the drivers.
4, Click Next.
The Hardware Installation window displays.

Hardware Installation

1] E The software you are installing for this hardware:
L]

Osgprey-500Yideo Capture Device

haz not pazzed ‘Windows Logo testing ta werify itz compatibility

with ‘windows XP. [Tell me why this testing iz important. |

Continuing your installation of this software may impair
or destabilize the comrect operation of your system
either iImmediately or in the future. Microzoft strongly
recommends that you stop this installation now and
contact the hardware yendor for software that has
passed Windows Logo testing.

Continue Aryway ] [ STOP Inztallation |
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5. Click Continue Anyway.
The Found New Hardware Wizard window displays.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard
The wizard haz finished inzstaling the zoftware for:

@ D zprep-500 Video Capture Device
o

Click Finish to cloge the wizard.

6. Click Finish.
The Welcome to the Found New Hardware Wizard window displays for the audio
portion of the Osprey-500.

Found Hew Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps you install software far:

Osprey-500 Audio Capture Device

\'j If your hardware came with an installation CD
“4E2 or floppy disk. insert it now.

‘what do pou want the wizard to do?

() Install from a list o specific location [Advanced)

Click Mest to continue.

I MNest » l[ Cancel
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7. Click Next.
The Completing the Found New Hardware Wizard window displays.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard
The wizard haz finished inzstaling the zoftware for:

@ Dzprep500 Audio Capture Device

Click Finish to cloge the wizard.

8. Click Finish

If your system contains multiple Osprey-500 cards, you must restart your
computer before you can use all of the Osprey-500 cards. However, you
do not need to restart your computer if only one Osprey-500 card is

installed.

After completing the Found New Hardware Wizard, the software
applications must also be installed. Navigate to the WinXP directory on
the CD-ROM and double-click SETUP.EXE. For detailed instructions, see

Option A.
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Testing the Installation for Windows XP

1.  Verify that the hardware installation is complete according to the directions in
Chapter 2 - Osprey-500 Hardware.

2. Connect a video signal source to one of the Osprey-500 connectors
(Composite/S-video/SDI/DV).

3. Open the Osprey-500 group in the Start menu.

4. Click the VidCap32 icon. Refer to Chapter 8 - VidCap32 for more information
on this application.

5. If your input is composite video, the screen displays a still video frame from the
Osprey-500 board. Click the Overlay button. The screen should display moving
video frames. If your input choice is not composite video, select the Video
Source option under the Options menu. This brings up the Osprey-500’s video
capture driver configuration box where you can select your video input.

6. If the video area does not contain video, it could be for one of the following
reasons:

a. The driver is looking for video on the wrong input connector. You can either
move the video cable to another connector or reconfigure the driver using
its Control Dialog. Refer to Chapter 6 - Osprey-500 Video Control
Dialog.

b. The video source is not turned on or activated.

7. If the video area is scrambled or has bad color, the signal format of your video
source may be different from the signal format selected in the driver software.
Since the driver defaults to NTSC-M signal format, users of PAL equipment
always need to change the driver’s signal format the first time they run the
driver. Refer to Chapter 6 - Osprey-500 Video Control Dialog for more
information.

Uninstalling the Software

If you need to remove the Osprey driver from your system:

Open the Control Panel.

Double-click Add/Remove Programs.

Click to select Change or Remove Programs.

Highlight the Osprey-500 Driver entry.

Click Change/Remove in the Osprey entry.

The uninstall program begins.

Click Yes to proceed.

Click OK when the process is complete.

8. Please reboot your computer to finish removing the driver.

R .

N o
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Chapter 5 - Installing the Software -
Windows NT 4.0

The Osprey Capture Card products contains a single CD for Windows 2000 and
Windows NT 4.0.

After you've installed the software, you can test the card and software by running
the included application program VidCap32.

Please note:
+ Administrative privileges are required for installation.

+ Before installing software, check the ViewCast.com support
website or the ftp site for the any driver update releases
subsequent to the software shipped on your CD. For the
ViewCast.com support website, go to
http://www.ospreyvideo.com/> Downloads > Software &
Drivers > select WinNT and Osprey-500 from the table. To reach
the ViewCast.com ftp site, go to
ftp:/ /ftp.viewcast.com/pub/0OSP-500/winnt/latest. It's a
good idea to check these sites periodically for update releases.

¢ The screens used to illustrate the installation steps may not be
exactly what displays on your computer screen. In some cases,
version numbers and other minor differences may display in the
installation you are running.

¢ If you already have the Osprey driver software installed on your
system and are updating it, you do not have to remove the old
version before installing the new version. The installation program
removes or replaces any files or registry settings that are
& outdated.

If you have not installed Microsoft's DirectXMedia package, it is required
to run Windows Media Encoder 7. It is included on your Osprey-500 CD-
ROM. You can also download DirectXMedia from the following location:

ftp:/ /ftp.microsoft.com/developr/platformsdk/july2000/common
/redist/dxmedia

You should download the following files:

¢ x86/dxmedia.exe

¢ Xx86/dxm6pth.exe

¢ dxmins~1.htm

¢ license.htm

¢ redist.txt

The DirectXMedia package is distributed with Microsoft's DirectX 7.0a SDK
which can be ordered on CD from:
http://msdn.microsoft.com/directx/downloads.asp

The DirectXMedia pacage has also been distributed on the Patform SDK
CD-ROM within the MSDN subscriptions.
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Installing from CD

Downloading and Installing Updated Drivers

Setup Program: Details

Testing the Installation for Windows NT

Uninstalling the Software

Installing from CD

If necessary, follow the directions in Chapter 2 - Osprey-500 Hardware to install
the Osprey card. This software installation procedure works properly only if the card
is already installed.

1.

Turn on the machine and start Windows NT.

If you are updating from a previous version of the driver, it is necessary to
uninstall the old driver before installing the new driver. Please refer to
Uninstalling the Software for instructions.

Insert the Osprey-500 Driver CD into your CDROM drive. The installation
instructions assume this is the (D:) drive. Substitute the proper drive as it is
configured on your system, if necessary.

Run the installation program

a. Click the Start button

b. Click Run
c. Enter D:\WinNT\Setup in the dialog box
d. Click OK

The installation program steps are self-explanatory for many users. If you need
additional information, please refer to the section entitled Setup Program:
Details.

The driver and demo program are ready for use as soon as the installation
program completes and you have rebooted the system. We suggest you test
the driver immediately. Refer to the section entitled Testing the Installation
for Windows NT.

Downloading and Installing Updated
Drivers

Install the Osprey board in the PC if you have not already done so, turn on the
machine and start Windows NT.

2. The latest software drivers for Osprey-500 Capture Cards are available via FTP
(file transfer protocol) at the following location:
ftp:/ /ftp.viewcast.com/pub/OSP-500/winnt/latest
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There are also links to the drivers from our web site at
http://www.ospreyvideo.com/.

3. Use your web browser, such as Microsoft Internet Explorer or Netscape
Navigator, to find our FTP site and download the file. Type the FTP address
shown above into the address box at the top of your browser window. You may
find it simpler to type just the first part of the address -
ftp:/ /ftp.viewcast.com - and then click on the list of directories that display
until you have reached the winnt/latest location. Refer to your browser’s help
files for more specific and detailed assistance.

4, Download the web package in winnt/latest to your hard drive.
5. Itis necessary to uninstall your existing Osprey-500 driver before installing a

newer version of the driver. Follow the instructions in Uninstalling the Software
and restart your computer before beginning the new install procedure.

6. Run the web package program
a. Click the Start button
b. Click Run
c. Enter <pathname> in the dialog box, where <pathname> is the location

and name of the file that you have downloaded

d. Click OK.

7.  The program prompts you for a temporary location in which to unpack the
installation files and starts the setup program. The setup program guides you
through the installation steps. For many users this process is self-explanatory.

If you need additional information, please refer to the section entitled Setup
Program: Details.

The installation files are not automatically deleted after setup has run. If
you want to conserve disk space, make a note of the temporary location
where these files are being unpacked and delete them after the
installation.

8.  You must restart the computer before the driver and sample applications are
ready for use. We recommend that you test the driver immediately after
restarting your computer.
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Setup Program: Details

The setup program presents a sequence of windows and dialogs to guide you
through the setup process. In general, click the Next > button to continue to the
next screen. At any point you can click < Back to return to a previous screen or
Cancel to exit the installation.

1. The installation of the Osprey-500 Driver for Windows NT begins with a
confirmation that the setup program is beginning.

The Welcome window displays.

ViewCast Corporation - Deprey Video Division

O sprey-500 ¥ideo and Audio Capture Driver

Thiz program will install the Dsprep-500 for Windows NT
#8E Computers, Version 2.2.0 build 556.

Cancel

2. Click Next.
The Information window displays.

ViewCast Corporation - Osprey Yideo Division

Information

Pleaze read the following text.

You cah view thiz info later by opening the Readie file.

-
Oszprey Yideo Divizion ﬂ
iewCast Corporation

Osprey-500 Capture Diriver
For "Windows[R]NT
Yersion 2.2.0 Build 556
542042002

Sections in this file:

- Introduction -
4| | E

| rrstallStield

Cancel |
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3. Review the release notes for the Osprey-500.
4, Click Next.

The Software License Agreement window displays.

ViewCast Corporation - Dsprey Video Division

License Agreement

Pleaze read the following license agreement carefully.

Press the PAGE DOWHN key to see the rest of the agreement.

[EMD-USER LICEMSE AGREEMENT FOR WIEWCAST.COM il

IMPORTAMT, READ CAREFULLY. Thiz WiewCast.com End-User License Agreement

[ELILA)

iz a legal agreement between you [either az an individual or a zingle entity or

corporate entity] and YiewCast.com, Inc.., for the software product identified

above, which includes computer software and associated media and printed

materials [if any). and may include online or electronic documentation [SOFTWARE
PRODUCT or SOFTWARE). By instaling, copying, or otherwise using the SOFTWARE
FRODUCT, you agree to be bound by the terms of the ELILA. If you do not agree to ;I

Do you accept all the terms of the preceding License Agreement? |f you choose Mo, the
setup will clogze. Toinstall the Ozprey-500, pou must accept this agreement.

i =

< Back Yes No

5. Click Next.

6. Review this message and make sure that the licensing terms are acceptable.

Click Yes to accept the agreement. If you do not wish to accept the agreement,
click No to terminate the installation routine.

The Setup Type window displays.

ViewCast Corporation - Osprey Video Division

Setup Type

Choose the setup tupe that best suits your needs.

Pleaze chooze the signal format which vou want ta set as the default.

© PAL-BOHGI [Eunope)

| rrstallStield

< Back | Mest > I Cancel
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7.  Click to select the default Video Standard for the Osprey-500.
8. Click Next.
The Choose Destination Location window displays.
ViewCast Corporation - Dsprey Video Division
Choose Destination Location
Select folder where Setup will install files.
Setup will inztall the Osprey-500 in the fallowing Folder.
Tainstall to this folder, click Nest. Toinstall to a different folder, click Browse and select
anather folder.
Destination Falder
’7C:\Program Filesh0sprep-500 Browse... |
i =
Cancel |
9. The destination location is the folder where VidCap32 (the demo applet),
ReadMe, and other auxiliary files are located. (The core video capture driver
files are located in Windows NT system directories regardless of the destination
location chosen here.) The default location, in the Program Files folder, should
be appropriate for most systems. Click the Browse button near the bottom of
the dialog if you want to change the location.
The Select Program Folder window displays.
ViewCast Corporation - Osprey Video Division
Select Program Folder
Pleaze select a program folder.
Setup will add program icons to the Program Folder listed below. *'ou may tupe a new folder
name, or zelect one from the existing folders list. Click Mest ta continue.
Program Folders:
[E 0]
Ezisting Folders:
Adrninistrative Tools [Commaon]
Adobe Acrobat 4.0
HP Info
InCtrS
MATROX POWERDESK NT
MEDIAMATICS DVDEXPRESS
METSCAPE INSTALLATION
R
Stattup =
| rrstallStield
< Back | Mest > I Cancel |
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10. The setup program suggests placing the Osprey icons in a new program folder
entitled “Osprey 500.” You can change this name by editing the Program
Folders field, or you can add the icons to an existing folder by highlighting it in
the Existing Folders window. Click Next to continue.

The Start Copying Files window displays.

ViewCast Corporation - Deprey Video Division

Start Copying Files
Feview settings before copying files.

Setup has enough information to start copying the program files. |f you want to review or
change any zettings, click Back. |f you are zatizfied with the settings, click MNest to begin
copying files.

Current Settings:

Destination Directon: ;l
C:\Pragrarn Files\0zprey-500

Program Folder:
Osprey-500

L o

| rstallStield

Cancel |

11. Click Back to modify the directory and program folder destinations or click
Next to continue. The installation program copies the files to their destinations,
sets up the Osprey driver registry entries, and starts the driver.

The ViewCast Corporation — Osprey Video Division shortcut window displays.

ViewCast Corporation - Dsprey Video Division

12. Click Yes to place the Osprey Special Offers shortcut on your desktop. If you
do not want the shortcut on your desktop, click No.

If another kind of video capture driver is already installed on your system, the
question below displays.

O sprey-500 Yideo Capture Driver

\?e) [ro you want to make thiz wour primany video capture driver?
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13.

14.

15.

Click Yes to make the Osprey driver your primary video capture driver, unless
you have a particular reason for doing otherwise. Refer to Appendix D - Using
the Osprey Video Capture Driver with Other Drivers for more detailed
information about this message.

If another kind of audio capture device such as a soundcard is already installed
on your system, a message similar to the one above displays asking, “"Do you
want to make this your primary audio capture driver?”

O=prey-500 ¥ideo Capture Driver i

I::\.’K) [ro you want to make this vour primary audio capture driver?

Ll

Click Yes to make the Osprey audio driver your primary audio capture device or
click No to continue using your soundcard as your primary audio recording
device.

The Product Registration window displays.

PRODUCT REGISTRATION [ ]

@ wionld you like to register the O zprey 5007
Mo |

Click Yes to open a web browser window and register your Osprey-500 card at
the Osprey Video website. Click No if you would like to register your Osprey-
500 card later.

9 The installation continues after you close the browser window.

The Setup Complete window displays.

YiewCast Corporation - Dsprey Yideo Division

Setup Complete

The Ozprey-500 program group containg icons for the
WidCap32 sample applet and for the ReadMe. Fun WidCap32
to best and calibrate the driver. “rou will need to restart the
machine before uging the Osprey-500.

& Hes | warl to restart my computer now.

0 Mo, | will restart my computer later.

Remove any dizks from their drives, and then click Finizh to
complete setup.

< Back | Finish I
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16. Click Finish.
17. You must restart Windows NT.

& To change your setup at a later time, see Chapter 7 - Capturing Audio.

Testing the Installation for Windows NT

1.  Verify that the hardware installation is complete according to the directions in
Chapter 2 - Osprey-500 Hardware.

2. Connect a video signal source to one of the Osprey-500 connectors
(Composite/S-video/SDI/DV).

3. Open the Osprey-500 group in the Start menu.
4.  Click the VidCap32 icon.

5. If your input is composite video, the screen displays a preview mode window
with live video. Click the Overlay button. The screen should display moving
video frames. If your input choice is not composite video, select the Video
Source option under the Options menu. This brings up the Osprey-500 video
capture driver configuration box where you select your video input.

6. If the video area does not contain video, it could be for one of the following
reasons:

a. The driver is looking for video on the wrong input connector. You can either
move the video cable to another connector or reconfigure the driver using
its Control Dialog. See Chapter 6 - Osprey-500 Video Control Dialog.

b. The video source is not turned on or activated.

7. If the video area is scrambled or has bad color, the signal format of your video
source may be different from the signal format selected in the driver software.
Since the driver defaults to NTSC-M signal format, users of PAL equipment
always need to change the driver’s signal format the first time they run the
driver. See Chapter 6 - Osprey-500 Video Control Dialog.
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Uninstalling the Software

If you need to remove the Osprey driver from your system:

Open Control Panel.

Double-click Add/Remove Programs.

Click the Install/Uninstall tab.

Click to select the Osprey-500 Driver in the list of programs.
Click Add/Remove.

The uninstall program begins.

Click Yes to proceed.

Click OK when the process is complete.

8. Please reboot your computer to finish removing the driver.

iAW e

N o

You have the option of deactivating the Osprey drivers without
permanently uninstalling them. For example, this option allows you to use

& another device as your primary video capture device. Refer to Appendix
D - Using the Osprey Video Capture Driver with Other Drivers for
more information.
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Chapter 6 - Osprey-500 Video Control
Dialog

Accessing the Dialog
General Features of the Dialog

The easiest way to become familiar with the video capabilities of the Osprey-500
cards is to run the included video capture application VidCap32 and look at its menus
and dialogs. Chapter 8 - VidCap32 focuses on the underlying video capture driver
and the control dialogs that you can access from VidCap32.

The Osprey-500 video capture driver has a unified tabbed dialog for setting up all
driver parameters. There are six pages within the dialog:

The Source Page

The Format Page

The Closed Caption Page

The Configuration Page

The Advanced Features Page

The Logo Page

The SimulStream Page (described in detail in the SimulStreaming User's Guide)

The menu selections Options -> Video Source and Options -> Video Format
access the Control Dialog's Source and Format pages, respectively.

The selection Options -> Video Display accesses the Closed Caption page.

Accessing the Dialog

The normal way to access the dialog is through a menu entry or control button
belonging to the application program. For example, VidCap32 offers the following
three menu entries for accessing the dialog: Options > Source, Options >
Format, and Options > Display. Once you are in the dialog, you can move to any
other page by clicking on its tab. For example, to access the Configuration page from
an application, open the Source, Format, or Display (Closed Caption) page and click
the Configuration tab.

Instructions for Windows NT 4.0
Instructions for Windows XP

Instructions for Windows 2000
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You can open the dialog through the Control Panel at the same time another
application is accessing the card. This is useful if the application does not provide an
access control to the dialog. When you open the dialog through the Control Panel,
some changes such as adjustments to brightness, contrast, etc. display immediately.
Others will not take effect until the application is restarted.

Instructions for Windows NT 4.0

Open My Computer -> Control Panel -> Multimedia.
Select the Devices tab.

Open Video Capture Devices.

Highlight Osprey-500 Video Capture Driver.

Click Properties.

Click Settings....

ok

Instructions for Windows XP

1. Open My Computer -> Control Panel -> Sound, Speech, and Audio
Devices.

Click Sounds and Audio Devices.

Click the Hardware tab.

Select Legacy Video Capture Devices.
Click Properties.

Click the Properties tab.

Select Osprey-500 Video Capture Driver.
Click Properties.

Click Settings.

© XN UAEWN

Instructions for Windows 2000

Open My Computer -> Control Panel -> Sounds and Multimedia.
Select the Hardware tab.

Double-click Legacy Video Capture Devices.

Click the Properties tab.

Select Osprey-500 Video Capture Driver.

Click Properties.

Click Settings.

Nous W=
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General Features of the Dialog

These are the common elements found on all pages of the dialog.

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Source I Formatl Clozed Eaptionl Logo I Advanced Featuresl Eonfigurationl SimuIStreamI

—Wideo Setting — lhpLit

W —————— |————— Biightness
IW ———— |————— Contrast
l? —— |———— Saturation
[ls | ——————— Hue

" SVideo
50l
D [IEEE 1394)

= Emass Galbr o et

— Wideo Standard

& NTSC-M  PAL-BDGHI

Riestore Previous |

Restore Defaults |

Ok I Cancel I Help |

OK

Cancel

Restore Defaults
Restore Previous
Apply to All Boards
Help

OK

The OK button exits the dialog, saving the settings you have currently chosen. If you
have made changes on two or more pages of the dialog, or for two or more boards,
all of these changes are saved.

Cancel

This button exits the dialog box without saving any changes. If you have made
changes on two or more pages of the dialog, or for two or more boards, all of these
changes are discarded.
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Restore Defaults

This button restores the settings on the current page, for the currently selected
board only, to the way they were when the Osprey software was installed.

Restore Previous

This button restores the settings on the current page, for the currently selected
board only, to the way they were at the start of the previous dialog session.

Apply to All Boards

This option displays on relevant dialog windows when more than 1 Osprey card is
installed in a system. The only dialog window tabs that can apply an operation to
multiple boards are Closed Caption and Logo. The settings for all the boards are
saved when you click OK; or all are discarded if you click Cancel.

Help

Clicking Help accesses the pages of this manual covering the currently selected tab.
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The Source Page

Use the Source page to set the characteristics of the input video.

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Source I Formatl Clozed Eaptionl Logo I Advanced Featuresl Eonfigurationl SimuIStreamI

—Wideo Setting — lhpLit

W —————— |————— Biightness
IW ———— |————— Contrast
l? —— |———— Saturation
[ls | ——————— Hue

" SVideo
50l
D [IEEE 1394)

= Emass Galbr o et

— Wideo Standard

& NTSC-M  PAL-BDGHI

Riestore Previous |

Restore Defaults |

Ok I Cancel I Help |

Input
Video Standard
Video Settings

Bypass Color Correction

Input

The Input field has buttons for the card’s Composite, S-Video, SDI and DV input
connectors.

If Preview or Overlay mode is enabled in your application, you can usually see the
results of your selection immediately without exiting the dialog. However, if you
switch between inputs that have two different signal formats, such as NTSC or PAL,
the video does not display correctly until you exit the dialog.
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Video Standard

Video Standard or Signal refers to whether the video signal format is NTSC or PAL.
Depending on the exact product version you have, buttons for some or all of the
following formats are displayed:

NTSC-M - North America

PAL-B, D, G, H, I - many countries in Europe and elsewhere. B, D, G, H, and I refer
to five nearly identical subformats.

Full-sized NTSC-M, NTSC-J, and PAL-M have 525 lines total, 480 lines visible, per
frame and a display rate of 60 fields per second, or 30 interlaced frames per second.

Full-sized PAL (other than PAL-M) and SECAM have 625 lines total, 576 lines visible,
per frame and a display rate of 50 fields per second, or 25 interlaced frames per
second.

The standard frame sizes are different for NTSC and PAL. For example, the half-
frame size in pixels is 320x240 for NTSC, and 384x288 for PAL. If you have selected
a standard frame size (Full, 1/2, 3/8, or 1/4), the driver automatically adjusts the
frame size to correspond to the standard. If you have created a custom size, it does
not change when you switch between NTSC and PAL/SECAM.

Changes to the signal controls do not take effect until you exit the dialog.

Video Settings

These four slide controls set Brightness, Contrast, Hue, and Saturation. These
settings are stored separately for each video source.

NOTE: When using these controls, be sure that the preview mode or overlay mode is
enabled, so that you can immediately see the effects of your changes.

When a video source with PAL signal format is used, the Hue setting is not adjustable
and the Hue control is grayed out.

When using a digital source (SDI or DV), the Brightness, Contrast, and Saturation
settings do not affect encoded video. The Hue setting is not adjustable on SDI and
DV video sources.

The Restore Previous or Restore Defaults button can be used to restore the previous
video settings.
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Bypass Color Correction

Check Bypass color correction to turn off all saturation, contrast, and brightness

conversion in hardware and pass digital video data directly to the host. This is most
useful for the SDI and DV input sources. This checkbox applies ONLY to digital video

sources.

The Format Page

Use the Format page to set the color format and size of the image.

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Source  Format |Closed Eaptionl Logo I Advanced Features Eonfigurationl SimuIStreamI

— Color Format—————— — Propaoitions

& Standard
IHgb15 'l

= CCIRBOT

T~ Enable Cropping

—Wideo Size - Custom Size

Full 320 width
LO ]

240 Height
8
14 ™ Lock Ratia
™ Custam

N
ViewCast

CORPORATION

Restore Previous |

0K

Cancel I Help

Color Format
Video Size
Custom Size

Proportions (Pixel Aspect Ratio)

Cropping (please see the CropApp Manual for detailed instructions on using this

feature)
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Osprey-500 DY Pro Yideo Capture Driver, Yersion 2.2.0

Source  Format |Closed Eaptionl Logo I Advanced Features Eonfigurationl SimuIStreamI

— Calor Farmat Propartions
& Standard
IHgb15 v[
= CCIRBOT
¥ Enable Crapping
Source  Cropped  Left Output
Size Size Top Size _.\
Harizontal |84D |320 |n |320 ViewCast
CORPORATION
Yerlical |4ED |24D |n |24u
Riestore Previous |

Ok | Cancel I Help |

Color Format

The Color Format is the arrangement of data bits representing the colors of each
pixel. For example, in the RGB15 format, each pixel of data is stored as 5 bits of red,
5 bits of green, and 5 bits of blue color information.

Video delivered by the Osprey board to the system is in uncompressed format. It is
possible to compress the video at a subsequent stage of processing. However, this
dialog field refers specifically to the uncompressed raw video that the board delivers
to the system.

The color format you choose applies to Captured video and to Preview video. It does
not apply to Overlay video. Overlay video is always matched to the display adapter’s
current screen format - except when greyscale mode is selected. Overlay video is
therefore as fast and efficient as possible, but the color rendering may differ very
slightly from what you capture. Preview mode renders colors exactly, but it is slower
and consumes more system resources.

Changes to Color Format take effect only after you exit the dialog.

For a more detailed description of the color modes available, refer to Appendix B -
Color Modes.
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Video Size

The Video Size field allows you to select between the various sizes given below.
Changes made to Video Size take effect only after you exit the dialog.

Size Width x Height Also known as:
Full 640 x 480

1/2 320 x 240 CIF

3/8 240 x 180

1/4 160 x 120 QCIF

The width and height shown are in pixels for the North American NTSC-M video
format in the square (standard) aspect ratio. For further details, refer to Appendix
C: Video Sizes.

There is a fifth button, Custom, that becomes selected whenever a non-standard
size is entered in the Custom Size field. See Proportion (Pixel Aspect Ratio) for
more detailed information.

Custom Size

The Custom Size field allows you to set customized width and height values different
from the standard preset values of full, 1/2, 3/8, and 1/4.

If the Fixed Ratio box is checked, when you enter a new size in either the height or
width box, both dimensions are adjusted proportionately. If this box is unchecked,
the height and width may be entered independently. If the dimensions are different
from normal screen proportions, the image is stretched horizontally or vertically.

The Osprey video hardware is not capable of drawing all possible widths. Depending
on the color mode selected, it may require a width that is an even number of pixels
or, for YVU9 and YVU12, a width that is a multiple of 16. The dialog lets you enter
numbers that the hardware cannot utilize, but adjusts them as soon as you click on
another field or button of the dialog.

See Proportion (Pixel/Aspect Ratio) for more detailed information.
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Proportion (Pixel Aspect Ratio)

This dialog allows you to select between "Standard" (also called a Square aspect
ratio) and "CCIR601" aspect ratio.

The maximum resolution of the CCIR601 mode is 720 pixels for both NTSC and PAL.
The Standard/Square aspect ratio mode has a maximum resolution of 640 pixels for
NTSC and 768 pixels for PAL. However, the inputs to the Osprey-500 all operate in
the CCIR601 mode. The CCIR601 format is true of the analog inputs as well unless
the Osprey-100 Analog Mode is selected. Thus, it is recommended that only the
CCIR601 mode be used on the Osprey-500.

Note that since the sources are processed in a CCIR601 format, the full 768 pixels of
the standard/square aspect ratio mode of PAL is not available. Only 720 maximum
pixels are available. If the standard/square aspect ratio mode is selected for PAL, the
Osprey-500 drivers limit the maximum resolution to only 720 pixels.

Also, many digital sources provide only 704 true pixels and not 720 pixels per line.
Because of this, the Osprey-500 scales down from 704 pixels (i.e., a crop of 720 to
704) to the desired size. If 720 pixels are desired, for example, the result is an
unscaled 720 pixels in width. If 704 pixels are desired, the result is an unscaled 704
pixels in width. If 352 pixels are desired, the result is a scaling from 704 down to
352 pixels in width (and not 720 down to 352).

Cropping

Please see Cropping and Scaling in this guide and also in the CropApp Manual for
detailed instructions.
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The Closed Caption Page

Use the Closed Caption page to enable or disable Closed Captioning and to control its
characteristics.

Osprep-500 DV Pro Yideo Capture Driver, Yersion 2.2.0

Source  Closed Caption | Laogo I Advanced Features Eonfigurationl SimuIStreamI
— Display on Screen— [~ Save to File
™ Enable ™ Enable ¥ Apply changes o
_ all boards rather
% OverVideo re— thar jst the ane
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Erowse |
—Mode
& Yideo ]
 Tent ﬂ\
ViewCast
CORPORATION
— Channel r— Test Calar
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- N 5 I
Restore Defaults |
Ok I Cancel I Help |

Display on Screen
Save to File

Mode

Channel

Text Color

Apply to All Boards

Closed Captioning is a method of encoding and displaying text such as movie dialog
captions or stock quotes as part of NTSC video. The text is similar to movie subtitles
in appearance. Closed Captioning is widely available on broadcast video, cable,
videotapes, and videodisks.

The Osprey-500 video driver provides a complete implementation of the Closed
Captioning standard and special extensions that are made possible by the capabilities
of a PC. At the moment, the Osprey-500 only provides support for Closed Captioning
on the analog video inputs. For more information, see No Closed Captions on
Digital Video in Chapter 9 - Troubleshooting.
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You can use Closed Captioning whenever the following conditions are met:

¢ You must be viewing a videotape, videodisc, or broadcast material that has
Closed Captioning content. Look for a small *CC” logo on the packaging or in
the program listing.
Closed Captioning is for North American NTSC video only, not for PAL video.

Closed Captioning must be enabled in the Osprey driver, using the Closed
Caption dialog page as explained above.

+ Video Mode and Channel 1 must normally be selected as explained above.
You might use Text Mode or Channel 2 in specialized instances.

+ In addition to the normal options of viewing or capturing Closed Captioning,
you have the special capabilities to save the text to file as you view or
capture it.

Display on Screen

The Enable checkbox enables display of Closed Captioning on the screen if it is
checked and disables it if it is unchecked. Closed Captioning currently only is enabled
for analog (Composite/S-Video inputs).

If you check or uncheck the Enable checkbox while Overlay or Capture mode is in
effect, the change does not take effect until Overlay or Capture is stopped and
restarted.

It is recommended that you disable Closed Captioning when using non-Closed
Captioned video. If you leave Closed Captioning enabled, the software attempts to
interpret regular video as Closed Captioning character codes, and may sometimes
display spurious characters. It also slightly increases the driver’s CPU usage.

The normal display mode is Over Video. In this mode the Closed Captioning is
superimposed on the video field.

The Own Window option is a special proprietary mode for Closed Caption display. A
separate window displays, and the text scrolls up in this window instead of appearing
on the video field. This window disappears while you are capturing video and
reappears after capturing video. This mode may be useful for some kinds of material,
as the lines of text are not erased as quickly. The Own Window option, however,
does not fully conform to Closed Caption standards, especially with regard to line
placement. It may therefore give undesirable results with some kinds of highly
formatted captions.
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Save to File

A nice feature of Closed Captioning on a PC is that you can save the captions to a file
for later review. The Save to File field contains three controls:

1.  If checked, the Enable checkbox enables saving to a file.
The Edit Box allows you to designate a file in which the captions are saved.
3. The Browse button accesses a standard system dialog for locating a directory
and file in which the captions are saved. When you choose a file that already

exists (either by entering the file name or using the Browse button), new
captions are appended to whatever was previously in the file.

You may enable saving to a file without enabling display of Closed Captioning on the
screen; the two checkboxes are independent.

When SimulStream is in use, only one closed caption session is available
to save to a file.

Mode

Video is the normal Closed Captioning display mode used with almost all videos and
broadcast TV. Text is a specialized mode in which the entire 32 character by 15 row
Closed Captioning area of the screen is blanked and used to display text. Use Video
mode unless you know specifically that the material is Text mode.

Channel

Channel 1 is the channel normally used in almost all Closed Captioning. Some
specialized material may use Channel 2.

Note that with most material, if you select Channel 2, you won't see any
Closed Captions.

Text Color

Select the color in which you want the closed captioned text to display.
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Apply to All Boards

If multiple boards are installed, changes can be applied to all of the installed boards
simultaneously. If you only want to apply the changes to the selected board, do not
select the Apply to All Boards check box.

The Logo Page

: VidView =] B3] - vidview O] x|
File Edit Optionz Help File Edit Optionz Help

| |
The Osprey Video Capture Driver allows you to superimpose a logo on captured

video, as in the images above. The “VCST” logos shown illustrate some of the
features for color keying and translucency that are described below.

Use the setup dialog’s Logo page to set up a logo. The logo page is actually a
sequence of five pages that guide you through the steps of creating a logo and
placing it on the video.

You cannot access the Logo page directly from most applications. Instead, open the
Source or Format page of the dialog, then click on the Logo tab.

Capabilities

Step O - Before You Start

Step 1 - Creating and Enabling the Logo
Step 2 - Selecting the Logo File

Step 3 - Setting Key Color and Style

Step 4 - Positioning the Logo

Step 5 - Reviewing and Saving the Changes

Notes on Logos
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Capabilities

A logo can be any artwork that is formatted as a 24-bit BMP file. Typically, a logo is a
small graphic that is placed at the lower left of the image. In a technical application,
however, a logo could be a crosshair pattern placed at the center of the image. The
logo can theoretically be any size. However, the CPU must actively draw the image
on every frame of video, and drawing a very large image, even if it is mostly
transparent, degrades overall performance in high-throughput applications.

The driver can draw a logo on captured or streaming video, on preview video, or on
DibDraw overlays. However, the driver cannot draw a logo on DirectDraw overlays. If
you attempt to draw a logo on DirectDraw overlays, everything appears to work fine,
except that the logo is not visible.

A logo’s rectangle can be partially transparent so that the underlying video is visible.
The transparent areas are defined by a Key Color — a particular (red, green, blue)
value that is specially interpreted by the driver. For example, the sample logos use
cyan with red, green and blue values of (0, 128, 128) as the key color.

A logo displays in either of two styles — normal and embossed. In normal style, the
logo’s non-transparent pixels simply replace whatever video underlies it. In
embossed or translucent style, the logo's non-transparent pixels are averaged with
the underlying video pixels, resulting in a more subtle effect.

For detailed instructions on setting up a logo, review the following steps:
Step O - Before You Start

Step 1 - Creating and Enabling the Logo

Step 2 - Selecting the Logo File

Step 3 - Setting Key Color and Style

Step 4 - Positioning the Logo

Step 5 - Reviewing and Saving the Changes

Notes on Logos

Step O - Before You Start

Create your artwork with the Windows Paint application or any other paint program
that you like to use. Save it in 24-bit BMP format.

Before creating your own logo, however, you may want to experiment with the
samples supplied with the driver. They are located in the Osprey program directory,
by default \Program Files\Osprey 500\Nt on the default drive.
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Have Preview or DibDraw Overlay mode running when you enter the dialog to see
immediately the results of interactively defining and placing the logo. DirectDraw
Overlay mode does not work for this purpose. To change from DirectDraw to
DibDraw,- or to find out which one you are currently using — go to the dialog’s
Configuration tab, then stop and restart Overlay mode.

Step 1 - Creating and Enabling the Logo

Additional links:
The Logo Page

Capabilities

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Sourcel Formatl Closed Caption  Lege | Advanced Features Eonfigurationl SimuIStreamI
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not to DirectDraw. You will then be able to interactively "\

place the logo on the video display. v-
iewCast

After the Iogo_is zet up, set o\{erlay video to DirectD_raw CORPORATION

mode far maximurn efficiency in capture and streaming.

<4 Brey.

Ok | Cancel I Help |

As you can see, the logo setup pages include detailed explanations at each step.

The first page handles only one consideration - whether logo drawing is enabled or
not.

By default, the Enable box is not checked and therefore no logo displays. In this
case, when you click Next>> you go directly to the last page (page 5) of the logo
setup sequence.

If the Enable box is checked, you can click Next>> to step through all of the pages
of the setup sequence.
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Step 2 - Selecting the Logo File

Additional links:
The Logo Page

Capabilities

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Sourcel Formatl Closed Caption  Lege | Advanced Features Eonfigurationl SimuIStreamI

— Bitrap File

|
Browse... |

Frepare vour logo in .BMP format. Use the Windows
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MOTE: Save the bitmap in 24-BIT format.
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color keying options described on the next page. CORPORATION
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Ok | Cancel I Help |
Logo Bitmap File
Look in: I_\]Nt j il bt
vzt bmp
vzt bmp

File name: |vcst2.bmd Open I
Files of type: [ fles = Cancel |

This screen should be nearly self-explanatory. You are selecting a BMP file, either
your own artwork or one of the samples. You can type in the full pathname to the file
or browse for it. When you have selected the file, click Next>>.

The sample logos are located in the Osprey program directory, by default \Program
Files\Osprey-500\Nt on the default drive.

Osprey-500 User's Guide - Version 2.2.0 101



Chapter 6 - Osprey-500 Video Control Dialog

Step 3 - Setting Key Color and Style

Additional links:
The Logo Page

Capabilities

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0
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As previously noted, a key color is a (red, green, blue) color value that the driver
treats specially. Logo pixels in that color do not display; the underlying video
displays instead. This dialog sheet lets you choose one of four fixed key colors, or no
key color. If you select None for the key color, all pixels from the logo display
including all pixels in any of the key colors.

A key color must be a precise (red, green, blue) value. For example, if cyan is
selected as a key color the pixel values must be exactly (0, 128, 128). A pixel of
value (0, 127, 127) does not display transparent - it displays as cyan.

All four key colors are standard stock colors in Windows Paint.

If the Embossed box is checked, each pixel color value displayed is the average of
the pixel value of the logo and the pixel value of the underlying video. If Embossed
is not checked, the pixel color value is simply the value from the logo.

The key color setting takes precedence over the Embossed setting; that is, logo
pixels in the key color are transparent, not averaged, even in Embossed style.
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Step 4 - Positioning the Logo
Additional links:

The Logo Page

Capabilities

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Sourcel Formatl Closed Caption  Lege | Advanced Features Eonfigurationl SimuIStreamI

— Pazition —Mudge
uj
L ]
ol
ViewCast
CORPORATION
Drrag the logo to the desired position. Use the Mudge
buttons to make exact adjustments.
Mext »» I

Ok | Cancel I Help |

The Position control allows you to position the logo by dragging it with the mouse.
The Nudge controls move the logo up, down, left or right one pixel at a time. They
permit more precise adjustments than the Position control can achieve.

If Preview or DibDraw Overlay video is running, the logo moves on the video as you
move it in the dialog.

If you position the logo in a certain way and then change the video size, the driver
stretches the logo to maintain the same relative size, and places it in the same
relative position. The stretched artwork may have jagged diagonal edges and not
look as good as unstretched artwork prepared with the intended video size in mind.
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Step 5 - Reviewing and Saving the Changes

Additional links:
The Logo Page

Capabilities

Ozprep-500 DV Pro Video Capture Driver. Version 2.2.0

Sourcel Formatl Closed Caption | Advanced Features | Configuration | SimulStream  Lego |

—End

Here iz a summary of your curent logo settings:

Logo enabled.
File:

C:\Program Files\Osprey-5008W T4 CLoga brap
F.ey color: none
Style: not embossed
Size: B8 pivels high » 105 pixel: wide
Position: 46 pixels fram top, 198 pixels from left

: e _ _ ViewCast
If you check this button, pour changes will be applied to CORPORATION
all boards rather than just to the currently selected
board.
4< Prev I flEwt > I
Ok | Cancel I Help |

This page shows a text summary of the current logo configuration.

If you have multiple boards in the system, a checkbox entitled Apply to all Boards
is shown. If you check this box, the logo changes you make to the current board are
made to all the boards in the system.

If you have multiple boards in the system and the only change you make
is to enable or disable logos, clicking OK with Apply to All Boards
checked changes the enable/disable status of all boards but doesn't
change any of the other settings. If, however, you make any logo
changes other than enable or disable, Apply to All Boards copies the
entire current configuration to all boards.
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Notes on Logos

If you set up a logo with video set to one size, then resize video, the logo is scaled
correspondingly. For example, if the logo is originally set up for 320 x 240 video, and
you change to 640 x 480 video, the logo displays at twice the size of the original
bitmap.

1. If you edit the logo settings while the logo is scaled up or down, an additional
option entitled Rescale displays after Enable.

Osprep-500 DV Pro Yideo Capture Driver, Yersion 2.2.0

Sourcel Formatl Clozed Eaptionl Advanced Features | Configuration | SimulStream Logo |

-~ Rescale

Rescale |

“Y'ou have changed video size zince setting up the loga,
and the logo has been scaled to the new video size.

Click this button to reset the logo to the unscaled size of
the original logo bitmap.

N
ViewCast

CORPORATION

Mext > I

Ok | Cancel I Help |

If you click the Rescale button on this page, the logo is resized to the same
size as the original source bitmap.

If you do not click the Rescale button, you can edit the logo settings using the
scaled logo. Even if you change to another bitmap image, the old scaling is
maintained.

2.  The driver can display color logos on YUV video - 4:2:2 packed, YUV12 planar,
and YVU9 planar. The appearance may not be quite the same as the RGB
version, however.

3. Detail of colored features may not be as crisp, because in the YUV modes color
is not sampled at full pixel resolution.

DibDraw Overlay video is always RGB even when you have selected a YUV
color format in the dialog. Preview video is always in the exact YUV or

& RGB format you have selected. Therefore, when using a YUV mode be
sure to check the appearance of the logo in Preview mode before putting
it to use.

4. When Grey8 video format is selected, all logos including color logos are
displayed in greyscale.
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The Advanced Features Page

Select a link below the screen for more information.

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Sourcel Formatl Closed Caption | Logn  Advanced Features Eonfigurationl SimuIStreamI

 Field Order

& Force odd-even

" Force evenrodd
— Deinterlacing

I Software filter

I Hardware filter \

ViewCast

r Transfer mode CORFORATION

' Odd/Even

Restore Defaults |

Ok I Cancel I Help |

Field Order
The De-Interlacing Motion Filter

The Transfer Mode

Field Order

The Osprey-500 allows you to configure which pairing of fields will be used to
construct a frame. This parameter is most useful when you are using a progressive
video source.

If you are using an interlaced video source, and have turned on the hardware de-
interlacing filter, choose 'Force odd-even' here.

If you are using a progressive video source, the hardware de-interlacing filter should
be turned off. Use the 'Force odd-even' or 'Force even-odd' setting with a
progressive scan camera to eliminate comb-like interlacing artifacts. Consult your
camera's technical documentation for the correct setting to use.
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The De-Interlacing Motion Filter

The Osprey-500 offers hardware and software de-interlacing. The software de-
interlacing is optimized for Windows 2000 and later; it will consume fractionally more
CPU cycles when enabled under Windows NT. We recommend that you choose
hardware de-interlacing.

If you are using a progressive video source, you do not need de-interlacing. Turn off
both hardware and software de-interlacing.

Most video is provided for viewing in an interlaced format. For simplicity, NTSC is
used in the following explanation of an interlaced format. NTSC video is basically
composed of images taken 60 times a second. Each image is called a field, and there
are odd and even fields. While these odd and even fields are temporarily adjacent to
each other in time, the horizontal lines that make up these fields are spatially
different.

Odd Field EwvenField
- - - - e P
e —————— [

The figure above is a simplistic view of interlaced video and fields. The two fields are
taken 1/60th of a second apart, and the lines of each field are not aligned, but
staggered. Most televisions are interlace display devices, where the 60 fields are
displayed individually and the viewer sees only one field at a time. However, most
computer monitors are progressive and not interlaced display devices. On a
computer monitor where video is viewed at its full resolution, viewers see both the
odd and even fields at once:
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O ddiEen

Lities from
the O dd Field

Lines from the
E-ven Field

The problem with progressive display devices is that if an object is moving, its
position is not the same in both the odd and even fields. When odd and even fields
are merged together, interlaced artifacts occurs. The artifacts are seen and
commonly described as streaking or feathering.

{1 ¥idCap M= E
Fie Edit Option: Zaptura kelp

e B

The screen above illustrates the streaking or feathering problem that occurred when
the interlaced odd and even fields in this video were captured. Only a slight amount
of motion took place, yet streaking is obvious in the overall result. Note the
prominent horizontal lines outlining all the objects on this screen.

When feeding such images to an encoder, the encoder has a significantly harder time
processing and compressing such interlaced video. The result is loss of overall quality
and perhaps a loss of frame rate as well. While the encoding process may smooth
out some of these artifacts, the resultant compressed video may still display
somewhat streaked or feathered and may not play back smoothly.
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) VidCap =

Fi= Edit Options Zapturs Eelp

e e el P )

The Osprey-500’s de-interlacing motion filter can be applied to any video source
prior to the optional scale and color-convert phases of processing to eliminate
streaking or feathering and maintain motion content. In the screen above, where the
Osprey-500’s de-interlace motion filter has been turned on, note that the strong
horizontal streaking or feathering around the subject’s head have been smoothed to
a slight blur. While the blur is noticeable in a single screen snapshot, the human eye
perceives only natural motion when the video is played back at normal frame rates.

Feeding the de-interlaced image in the screen above to an encoder significantly
improves output of the encoder in terms of overall quality and smoothness. The
encoder has an easier time compressing the de-interlaced video and thus can expend
saved bits and CPU cycles to produce higher quality streams.

The Transfer Mode

The Osprey-500 captures video data to the host or to the display device via two
different transfer modes. The first mode, Odd/Even, transfers video such that the
odd lines of video are grouped together before the even lines. If the video source
was interlaced to start with and the hardware de-interlacing filter was not applied,
the Odd/Even mode basically places the odd field on top of the even field. If the de-
interlacing filter was applied (see description further down), this mode places the odd
lines of the resultant de-interlaced frame before the even ones. The Odd/Even
transfer mode only occurs when the resolution is greater than half the maximum
resolution (>240 for NTSC and >288 for PAL).

The second mode, Interleaved, transfers video vertically in line order. For example,
line 1, line 2, line 3, etc. Basically, this is an interlaced mode. However, since the
video source may have been progressive to start with, or because the de-interlacing
filter may have been applied, the term ‘interlaced’ transfer mode is inappropriate.
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The following images further describe the Odd/Even and Interleaved transfer modes:

) VidCap =

Fi= Edit Options Zapturs  Eelp

e e e 5

]

The first image is a snapshot of video captured using the Interleaved transfer mode.
The source is an interlaced DV camera, and the image size is 640x480.

) VidCap =

Fi= Edit Options Zapturs EFelp

e O e P

——

The second image is a snapshot of video captured using the Odd/Even transfer
mode. The source is an interlaced DV camera, and the image size is 640x480.
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f#: YidCap =]

File Edit Options Capture Help

The third image is a snapshot of video captured using the Odd/Even transfer mode.
The source is an interlaced DV camera, and the image size is 320x480. This mode of
capture can be used to acquire video at 60 fields/sec. The Osprey-500 already
horizontally scaled the video down to 320 pixels in width in hardware. Having the 60
fields/sec delivered 30 times a second in the format given here offers the advantage

of keeping the odd/even pairing of video consistent in the case of capture loss due to
performance of the application.
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The Configuration Page

The Configuration page controls several miscellaneous settings.

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Sourcel Formatl Closed Eaptionl Logo I Advanced Features  Configuration | SimuIStreamI

— Owverlays — Default Capture Device

& Use Direct Draw (fast] |o500ve.dil - Osprey 500 Card 1 =]
" Use DibDraw [flexible]

) [rterlaee always (o slov: r~ Multiple Dpen

tiat vides - best detai .
matiam vidse - best detall ¥ Allove multiple opens of each board

) [anble e franm aneiteld [usually recommended - see help]

[far fastmotion siden - ma
Yeombt artifacts]

. N
AccesstoFormat Tab———————————— V|ewca st

CORPORATION

% Prevent access to dialog's
farmat tab via zource dialog
[default - maximum compatibility]

© Allow this access
[mazimum flexibility]

Ok Cancel Help

Overlays
Access to Format Tab
Multiple Opens

Default Capture Device

Overlays

Direct Draw is a fast drawing method that moves video directly from the Osprey
capture card to the display adapter. If Use Direct Draw is selected, the driver uses
Direct Draw for Overlay drawing. If for some reason it cannot use Direct Draw, it
automatically defaults to DibDraw.

Direct Draw works with the vast majority of display adapters and software driver. We
recommend running with Direct Draw enabled unless you are having a problem
viewing overlay video, or want to use the “doubled lines” option discussed below. For
more details on Direct Draw, refer to Appendix E - Direct Draw.

DibDraw is the default drawing method. Video is moved first into system memory
and copied to the display adapter. It is useful in the following cases:

1.  For systems where Direct Draw does not work correctly.

2. If you want to enable “line doubling”. When DibDraw is selected, two radio
buttons are enabled that let you choose between interlaced and line-doubled
video.
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Normally, video larger than 2-height (240 lines NTSC, 288 lines PAL) is interlaced.
NTSC and PAL video both consist of alternating odd and even fields of data. Odd
numbered lines come from the odd fields, even numbered lines come from the even
fields.

Interlaced video offers maximum resolution but suffers from a “comb” effect. When
there is rapid motion in the video, it displays blurred. It is recommended for still or
slow-motion video, but may not look good with high-motion content.

Line-doubled video uses video data from only one field. Each video line is copied to
two lines of your display. Line-doubling reduces the still-picture resolution by half;
however, it eliminates the “comb” effect of interlaced video and is therefore useful
for viewing rapid-motion video.

3. If you want to stretch the video on your screen beyond full size (640x480
NTSC, 768x576 PAL). You would need a special application to do this. DibDraw
video can be stretched but Direct Draw video cannot be.

Access to the Format Tab

The two options are:

+ Prevent access to a dialog’s format tab via source dialog
+ Allow this access

Video for Windows applications access the Source and Format pages as separate
commands and do not assume that the driver allows you to switch from one to the
other.

Some applications, when they access the Source page, do not check to see if you
also made changes to items in the Format page. The result is that the application
and the driver may assume different settings and not work properly together.

This control in its default “prevent access” setting prevents you from entering the
Source page or Closed Caption page, switching to the Format page, and
inadvertently making changes that the application cannot pick up. It also disables
the Board Select control on the Source and Closed Caption pages since the driver
maintains separate format information for different boards. The “prevent access”
setting is recommended for maximum compatibility with all applications.

The “prevent access” settings is, however, inconvenient. The alternative setting to
“allow this access” allows you to switch between pages without restriction. This
works with many applications; however, the responsibility lies with you to make sure
no problems arise.
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Multiple Opens

We recommend keeping this box checked unless you have a reason not to. This
ensures compatibility with the greatest number of present and future applications
that you might want to use.

If Multiple Opens is checked, a particular board can be opened for access from
multiple places, either within a single process or by multiple processes. However, the
features available through subsequent opens are limited. This mode is needed by
certain complex applications that, for example, use separate processes for capture
and overlay. In particular, Multiple Opens should be checked when utilizing Microsoft
Windows Media Encoder.

If Multiple Opens is unchecked (hunt mode), a particular board can be opened for
access from only one place in one process. If there are multiple boards in the
system, and an application tries to access a board that is already in use, the driver
hunts for the next available board. This is the easiest way to start multiple copies of
Windows Media Encoder or VidCap32, for example, to view multiple video inputs.

Changes you make take effect when you click OK to close the dialog. Applications
such as VidCap32 do not pick up changes until you restart them.

Review Appendix F - Multiboard Installations for more information.

Default Capture Device

This control is useful if you have multiple video capture devices of different kinds.
These could include cards from other vendors or different kinds of capture cards from
Osprey. In this context, the Osprey-50, -100, -101, and -200 are considered one
single device type. The Osprey-500, the Osprey-1000, and the Osprey-2000 are each
separate device types.

Some applications are capable of accessing only the primary or default device. With
this control you can select which device is the default device applications use.

Changes you make are written to the registry when you click OK to close the dialog.
Applications such as VidCap32 does not pick up changes until you restart them.
Some DirectX-based applications may not detect changes until you restart the
system.
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The SimulStream Page

SimulStream is an added-cost upgrade option described in detail in the
SimulStreaming User's Guide.

Osprey-500 D¥ Pro ¥ideo Capture Driver, ¥ersion 2.2.0

Sourcel Formatl Clozed Eaptionl Logo I Advanced Featuresl Configuration  Simul3tream |

E¥ w2

SimulStream is & purchasable option for Dsprey boards, Refer to
the SimulStream Users' Guide for a description of capabilities.

= fLlElE M Een

™| &lmvmultiple opens of each boand

[required far Simul Strean] . _‘\
ViewCast
Erefened Eapy Mode: CORPORATION

&) opy-ayoid [Hefault- uses minimur SR

) Copy-prefer (copies identical data to multiple steams]

Ok Cancel Help

Cropping and Scaling

The Osprey video capture driver package includes the capability to crop the incoming
video signal in hardware before it is encoded or captured. Cropping is done by the
Osprey card and imposes no extra load on the host computer. Use any of the
following methods to crop the incoming video signal:

Video Format dialog box
CropApp, the cropping application
SDK

Please see the CropApp Manual which is installed in the Osprey 500 Program group
for details on using this feature.
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Chapter 7 - Capturing Audio

Setup and control for audio are much simpler than for video. The basic steps are
covered in the following topics:

Select the Audio Source and Input Volume
Audio Formats

Missing Digital Audio Sources

Audio Playback

Note for DV users:

The Osprey-500 is capable of converting sampling rates from a higher sampling rate
to a lower sampling rate. For instance, if you set your DV audio to 48 kHz, the card
can provide all common sampling rates (48 kHz, 44.1 kHz, 32 kHz, 22 kHz, 16 kHz,
11 kHz, 8 kHz). If your DV audio is set to 32 kHz, the Osprey-500 driver can convert
to higher sampling rates.

Note for DVD users playing CD audio:

If you are playing a CD in a DVD player, the Osprey-500 is able to capture at all
sampling rates including 48 kHz. This is because the Osprey-500 driver can convert
audio from a lower sampling rate to a higher sampling rate.

Selecting the Audio Source and Input
Volume

The audio source is set using the Osprey-500's VFW mixer driver interface. Some
applications interface to the mixer driver directly and expose the look and feel
specific to that application. However, there is a DirectShow based mixer interface
that does not work with the Osprey-500's VFW mixer. If you are having problems
setting mixer settings (audio ports or gains), please contact support@viewcast.com
and we'll help you resolve that issue.

The default Windows interface to the mixer driver can also be used and is the
recommended way to set audio ports and gains on the Osprey-500. There are two
simple methods for getting to the mixer source and volume control dialog box.

0 Professional
copy. Build 2195

Open Yolume Controls

Adjust Audio Properties

o 2iepM
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The easiest method for accessing this interface is to right click the speaker
symbol on your taskbar (typically on the bottom right-hand side of your
screen). Then select the Open Volume Controls option.

If you do not see the speaker symbol, click the Start button on the Start Menu,
select Programs->Accessories->Entertainment (or Multimedia) and
select Volume Control. For Windows XP, select Start -> All Programs ->
Accessories -> Entertainment -> Volume Control.

Either of these two methods brings forth the audio mixer interface for the audio
playback device. To get to the Osprey-500 audio capture (recording) device,
select Properties under the Options menu. This pops up a dialog to select
the Mixer device. Do not select the Recording option within the Adjust
Volume for section; this option is selected automatically when you select the
Osprey-500 for the mixer device. Click on the dropdown list for Mixer device
to see the list of audio input and output devices, including the Osprey-500.

Properties x|

Mirer device: | [FSSTISIEATe

—Adjust wolume for
) Flaptiach

' Recording

£ [Wither I j

Show the following volume contrals:

Master Contral
UnB alanced Ana
Balanced Ana

VI ®LR AES/EBU -
« | »

oK I Cancel |

If more than one Osprey-500 card is in the system, each Osprey-500 card is
enumerated individually. Once an Osprey-500 device has been chosen, select
OK in the Properties dialog box.

The Osprey-500 Master Control panel displays.
0]

Cptions  Help

Record Contral | Unbalanced #LR Balanced | ®LR AES/EBU | RCAS/P-DIF Opt S/P-DIF [ [1394]

Balance: B alance: Balance: Balance: Balance: Balance: B alance:
2 T T R s e Pl R R
Volurme: Wolurne: Wolurne: Wolurne: Wolurne: Volurme: Wolurne:

T

V¥ Select [ Select [ Select [ Select I Select [ Select

|Osprey 500 Audic

The Osprey-500 device is not a mixer in that it does not allow for mixing the various
audio sources. Therefore, when one audio input is selected, any other input
previously selected becomes unselected. The Select checkbox at the bottom of each
source sets which source is actually being used. DV audio signals are embedded in
DB video signals. If you select DV audio, the video signal selection for PAL/NTSC
must match the state of the DV source.
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The Osprey-500 software has an optional gain control feature that defaults to being
on. When this feature is on, the 50% volume level for a given input results in no
modification to audio being captured. At a 100% level (the topmost level), gain is
increased by 2x.

The quick-access volume control (left click on the speaker symbol) on
& the task bar controls playback volume and recording volume. To change
record levels, go to Options, then Properties, and select Recording.

Audio Formats

The only Format that the Osprey-500 audio capture driver supports is PCM. The
driver supports the following data rates:

8 kHz
11.025 kHz
16 kHz
22.05 kHz
32 kHz
44.1 kHz
48 kHz

* & 6 6 o o o

These data rates are supported in 8-bit and 16-bit, mono and stereo formats. The
actual Osprey-500 hardware supports sampling of analog audio at 32, 44.1 and 48
kHz. Depending on the requested audio format, the Osprey-500 driver automatically
selects the most appropriate hardware sampling rate. For example, if 22.5 kHz audio
is desired, the audio driver selects the 44.1 kHz audio rate and down samples it to
22.05 kHz.

The Osprey-500 driver provides for optimal rate conversion from these base
sampling rates. For digital sources, the sample rate has already been determined.
The Osprey-500 automatically determines the digital audio sample rate and converts
this as required by the application’s requested sample rate.

It should be noted that the Osprey-500 does not currently dynamically readjust
sampling rates while audio capture is in progress. Thus audio capture should be
stopped and restarted whenever the audio input port changes.

For mono sources, the Osprey-500 uses only the left audio channel. Optionally, this
can be configured to be the left channel or a mix of the left and right channels.
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Missing Digital Audio Sources

Be sure to start the audio source before attempting capture. When a digital audio
source (such as DV or S/P-DIF) is selected before the audio is turned on, the Osprey-
500 is unable to determine the sampling rate. The sampling rate is a measure of the
amount of binary data needed to reproduce the audio being capture. If the audio
source is not available, the Osprey-500 cannot determine the format of the incoming
audio.

When a capture is started before the audio source is selected, the audio may not be
sampled at the correct rate. Audio sampled at an incorrect rate sounds slower or
faster than normal when it is played back. Should this occur, stop and restart
capturing audio.

The default digital audio sampling rate is 48 kHz. Some common sampling rates are:

¢ 48 kHz for DVD audio through S/P-DIF
¢ 44.1 kHz for CD audio through S/P-DIF
¢ 32 kHz or 48 kHz for DV recordings

Audio Playback

The Osprey-500 provides audio capture only, not audio playback. Continue to play
back captured audio using your system soundcard.
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Chapter 8 - VidCap32, Cropping and
Scaling, and Indeo

 VidView M= E3
File Edit Optionz Help

VidCap32 is a video capture application that is included with the Osprey package. It
is useful for testing the installation and for general purpose viewing of video. The
following instructions take you through the basic scenarios for using this applet. Also
see Cropping and Scaling.

Preview

Overlay

Single Frame Capture

Configuring the Video Capture Driver
Compression

Setting the Capture File — Preallocating and Defragmenting
Capturing Video

Playback

Control Panel

DirectXMedia Details

Ligos Technology Indeo

Cropping and Scaling
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Preview

The Preview button (first button on the left on the toolbar) toggles Preview mode on
and off. When Preview is enabled, the video you see is constantly updated and has
the exact format and appearance of uncompressed video capture.

Overlay

The Overlay button (second button from the left on the toolbar) toggles Overlay
mode on and off. When Overlay is enabled, the video you see is updated constantly.
The difference from Preview is that the Osprey driver uses the fastest and most
efficient drawing method it can. Normally, with Direct Draw enabled and working, it
draws at the full frame rate (30 per second) with minimal processor overhead.

Note that the Preview and Overlay buttons behave like radio buttons that cancel
each other - you do not have to shut off preview in order to start overlay.

Single Frame Capture

The rightmost button on the toolbar is used to capture a single frame. Every time
this button is selected, a single frame is captured and displayed in the window. You
can copy this image and paste it into other applications.

Configuring the Video Capture Driver

You can go through VidCap32 to access the Osprey driver’'s Control Dialog (described
in Chapter 6). The menu selections Options->Video Source... and Options-
>Video Format... access the Control Dialog’s Source and Format pages
respectively. The selection Options->Video Display... accesses the Closed Caption

page.
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Compression

It is possible to compress video as it is captured to disk. Neither VidCap32 nor the
Osprey video capture driver perform video compression themselves. However,
VidCap32 may be connected to external software-based compression modules.
Compression results in a much smaller capture file. The downside is that many types
of compression are slower: you may have to reduce your frame rate in order to avoid
dropping an excessive number of frames. With a “quick-compression” methods
running on a fast machine, however, the extra processing time is slight enough that
it is fully compensated for by the reduced time needed to write the more compact
data to disk.

When a compressor is enabled, video is passed from the Osprey capture driver to the
compressor, which then writes it to file. The compression dialog, accessed by the
Options->Compression menu item, allow you to select a compressor, or select no
compression. The information below for Ligos Technology’s Indeo compressor gives a
detailed example of how to perform this task.

Note that the list of available compressors is different for each video Color Format
selected in the Osprey video capture driver’'s control dialog. You should therefore
select the Color Format you are using first, then select the compressor. Otherwise,
you may get an error message when you try to begin video capture.

Setting the Capture File - Preallocating
and Defragmenting

The leftmost button on the toolbar (or the menu item File -> Set Capture File)
opens the Capture File dialog box.

Depending on a number of factors, you may experience a significant percentage of
frames dropped. The percentage of frames dropped is a function of frame size, use
of a compressor, and the speed of your system. Performance can be substantially
improved by preallocating a capture file and defragmenting it.

“Preallocating” a file means that space has been reserved for it on your hard disk.
The menu item File -> Allocate Disk Space brings up a dialog in VidCap32 by
which you can preallocate a file and reserve space large enough to hold the largest
video clip that you are likely to want to capture. In AmCap, it is the menu item

File -> Allocate File Space. You can preallocate multiple files to hold multiple video
clips.

For preallocation to be useful, the hard drive should be defragmented afterwards.
“Defragmenting” a drive reorganizes its physical sectors so that each file occupies
contiguous sectors, rather than having different parts of it scattered about the disk.
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AmCap and VidCap32 do not perform defragmentation; a third-party program is
required. Various defragmentation programs are available commercially, and if you
have Windows 2000 or Windows XP on the system you can use its built-in
defragmenter. Use AmCap or VidCap32 to preallocate the files, then exit to run the
defragmentation program.

@ NOTE: Defragment after you allocate and size the capture files.

After the disk is defragmented, return to AmCap or VidCap32. The files you
preallocated are now located in a contiguous areas of the hard drive. Their physical
layout remains the same until the file is resized or deleted.

An alternate technique that avoids the need for defragmenting is to set up a
separate disk partition dedicated to video capture, containing a single capture file.

Defragmenting is a time-consuming procedure, but is worth the trouble if you have
an ongoing need to capture high-quality video, particularly uncompressed video. Be
sure to plan the number and size of files you need. Once you have the defragmented
files, be sure not to accidentally delete them - think of them as your permanent
working space for time-critical operations, not as containers of specific video clips.
Copy your clips to other files for storage and editing.

Capturing Video

The second button from the right opens the Video Capture Dialog. This can also be
accessed by the Capture -> Video menu item.

Capture Yideo Sequence [ X|
Frame rate: |3D.DDD E

......................................................... . Cancel |
Seconds: |2D E .
= Audio... |
™ Capture audio Vid
Capture method &l
= Directly to disk
= Compress...
’7(" Capture to memary E4|
™| M cortrollof source vides AL |

The dialog includes controls to set the humber of frames per second, as well as an
optional time limit (in seconds) for the sequence. Buttons are provided to access
both the video capture driver’s configuration dialog and the compression dialog. You
can also access and configure audio, assuming that it is installed and enabled. The
dialog allows a choice between capturing video directly to disk, or capturing via
memory. Note that capturing to memory may result in fewer dropped frames - but
not necessarily.

For best quality video capture, use a capture rate (frames per second) that is slow
enough so that there are no dropped frames.
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Once the proper configuration is confirmed, click OK to capture the video. To end
capture, click the mouse anywhere in the VidCap32 window.

Playback

The simplest way to play back a video clip is to find its icon in "My Computer” and
double-click on it. This starts Windows Media Player, which automatically plays the
clip. Windows Media Player contains standard start, stop, and pause buttons and is
largely self-explanatory. Refer to Windows Media Player’s online help for more
information.

DirectXMedia Details

Microsoft® DirectX® Media is the media layer of the Microsoft® Windows®
multimedia system, providing multimedia playback and capture support, image
transformations, media integration, and animation for the Web and desktop.

Information Specific to Windows 2000 or Windows XP
Information Specific to Windows NT

General Information

Information Specific to Windows 2000 or Windows XP

Windows 2000 and Windows XP both already contain versions of DirectX® Media
suitable for applications like AmCap and Windows Media Encoder. The Osprey-500
driver and applications like Windows Media Encoder also work with the versions of
DirectX® that Windows 2000 and Windows XP install by default.

Information Specific to Windows NT

The DirectX® Media runtime is included on this CD, and can be installed by the
Osprey installation program. See the Readme.txt file for details. DirectX® Media
requires that Microsoft® DirectX® 3.0 or later be installed. Windows Service Packs 4
and later contain DirectX® 3.0. More information about DirectX and Windows NT is
available at http://www.microsoft.com/directx/homeuser/faq.asp - dx4
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General Information

More information about DirectX Media is available at:
http://www.microsoft.com/directx/homeuser/information/dx4nt.asp
and

http://www.microsoft.com/directx/homeuser/downloads/default.asp -
DirectX Media.

The DirectX Foundation Layer consists of Microsoft DirectDraw®, Microsoft
Direct3D®, Microsoft DirectInput®, Microsoft DirectSound®, Microsoft DirectPlay®,
and Microsoft DirectMusic®. Thus, DirectDraw is part of DirectX, and is another
reason that a video display adapter which supports DirectDraw is desirable.

More information about DirectX is available at:
http://www.microsoft.com/directx/homeuser/faq.asp

and

http://www.microsoft.com/directx/homeuser/aboutdx.asp

The latest version of all DirectX downloads can always be found at:
http://www.microsoft.com/directx/homeuser/downloads/default.asp

Because DXMedia is not part of the current DirectX releases, it can be downloaded
from:

ftp://www.microsoft.com/developer/platformsdk/july2000/common/redis
t/dxmedia

The DirectX Media package is distributed with Microsoft’s DirectX 7.0a SDK, which
can be ordered on CD from Microsoft. The DirectX Media package has also been
distributed on the Platform SDK CD in MSDN subscriptions.

Cropping and Scaling

The Osprey video capture driver package includes the capability to crop the incoming
video signal in hardware before it is encoded or captured. Cropping is done by the
Osprey card and imposes no extra load on the host computer. Use any of the
following methods to crop the incoming video signal:

¢ Video Format dialog box
+ CropApp, the cropping application
¢ SDK

Please see the CropApp Manual which is installed in the Osprey 500 group for details
on using this feature.
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Ligos Technology Indeo

Ligos Technology’s Indeo is a software video compressor that works with the Osprey
Video Capture Driver. It allows you to capture video to disk using much less disk
space, at the cost of only a slight loss of picture clarity. On a 300 MHz Pentium II
system you can capture 320x240 NTSC video at a full 30 frames per second with a
25:1 compression ratio.

Indeo is included on Osprey-500 driver CDs starting with Osprey-500 version 1.0.5.
Ligos Technology has acquired the Indeo® Media Software from Ligos Technology
Corporation. This codec is rather popular, so you may see references to both Ligos
Indeo and Ligos Technology Indeo for some months.

You can also download the most up-to-date version for free on Ligos’ web site. As of
this writing, the location is as follows:

http://www.ligos.com/indeo/downloads/

The file to download currently is ivSsetup.exe. You need a version that compresses
video as well as decompresses it.

Indeo Video compressor version 5.11 works with RGB24 and RGB15. It does not
work with YUV12 or YVU9. However, the Indeo package does include components
you can use to capture uncompressed YVU9 and 4:2:2 packed video.

Use the following steps to demo Indeo with the Osprey card:

3. Connect and adjust your video source. Start VidCap32.

4, Use the Options->Format... menu entry to bring up the Osprey driver’s
Control Dialog Format page. In the drop-down list in the Color Format field,
select RGB24 (or RGB15). Select ' sized (CIF) video. Click OK.

5. Use the Options->Compression... menu entry to bring up the compression
dialog. In the Compressor: field, select Indeo video 5.11.

Yideo Compression E [

LCompreszor: _DK
igos y 5! Cancel |
Compreszion Quality:. 85 o |
Al B
About... |
¥ Key Frame Every I‘I 5 frames

6. Before leaving the compression dialog, click the Configure... button. Enable
Quick Compress in the Encoder Controls field, and click OK.

NOTE: If you do not enable Quick Compress, compression is much slower.
Click OK again to close the Video Compression dialog box.
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— Encoder Controls Access el o
¥ Quick Compress ] Erable |_I_
™ Scalabilty Cancel |
irarsparency Load Default |
Y iewEnrt Sz About |
lm Help |

7. Select Set Capture File.. under the File menu. Set the name that you want for
the file that contains the captured video. Click Open.

8. Select Capture->Video. Select 30 frames per second for NTSC or 25 for
PAL/SECAM. Click OK. A confirmation dialog displays. Click OK again to start
capturing video.

9. Click anywhere on VidCap32 when you want to end capture

10. Open My Computer and navigate to the icon of the file you just captured. Click
on it and it plays back.

If you experience more than one or two dropped frames, use a lower frames per

second capture rate. Useful rates for NTSC video are 30, 15, 10, and 7.5; for
PAL/SECAM, 25, 12.5, 8.33, and 6.25.

Indeo has numerous options. You can obtain higher quality video and more
compression options by capturing uncompressed video and then compressing it off-
line.

Control Panel

&Dspley 500 Video Capture Driver Control Panel E
—Yideo Input —Yideo Adjustment:

' Compasite

J— EBrightness
 Sviden

'_J— Contrast
(=11
| Saturation

& DV (IEEE 1334)

J— Hue

W Eypass Color Corection

— Wideo Format
& NTSC

— Board 5elect

« PaL e o

The Osprey video capture driver package includes a Control Panel application that
allows you to control the video source while another application is running. Some
applications make it hard or impossible to access the driver’s control dialogs while
they are running. The Control Panel allows you to make these adjustments without
closing and restarting the primary application.
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Video Input
Video Format
Video Adjustments

Board Select

Video Input

The Video Input field controls which of the board’s physical inputs to use. The list of

available inputs may vary from the illustration depending on the exact hardware you
have.

Video Format

The Video Format field indicates whether NTSC or PAL video is selected and allows
you to change the format. NTSC is the video standard in North America and Japan.
PAL is the standard in most European countries, and many other countries as well.
For simplicity, NTSC and PAL are the only two formats that can be selected from the
Control Panel. The driver supports additional, less commonly used format with its
internal dialogs (see Chapter 6), in particular SECAM and PAL-M.

Video Adjustments

The Video Adjustment sliders allow you to interactively control the brightness,
contrast, saturation, and hue of the video being captured or displayed by the primary
application. PAL video does not have a hue adjustment.

Board Select

The Board Select field is displayed and used only when there are multiple Osprey
cards installed in the system. The buttons of this field determine which of two, three,
or four boards is currently being controlled.

the application is connected to. Their action is therefore slightly different

@ NOTE: These buttons affect which board is being controlled, not which board
from the Board Select controls in the driver’s internal Setup Dialogs.
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Blue/Pink/Black/Orange Video Screen

Blue Video Screen when using DV or SDI inputs
Black Preview Video Screen

Scrambled Video Image

Grainy, Dithered Image

Slow Overlay Drawing

Problems Using Direct Draw

Poor Video Quality at Large Frame Sizes

Wrong Capture Driver Being Accessed
Unwanted Closed Caption Text

No Closed Captions on Digital Video

Interrupt Conflicts

Multiple Horizontal Lines Across Video Image
Cannot Play Back Audio Recorded by the Osprey-500 Card

Video Control Dialog Windows are Empty under WinNT

Blue/Pink/Black/Orange Video Screen

The currently selected video input is not receiving an active video signal. Different
inputs may provide a different symptom when a video source is not supplied. For
example, with the Osprey-500 DV or Osprey-500 DV PRO, if no DV source is
connected to the card, the DV video may display as a solid pink screen. While playing
a tape in a DV camcorder, you may see an orange screen at end-of-tape. Video from
composite/S-video may display as a black screen (maybe with a single horizontal line
in it) or as a blue screen depending on whether or not the Osprey-100 Analog Mode
box is checked on the Osprey-500 Page of the video drivers configuration dialog.

1.  Check that the camera, VCR, or other video source is powered and that its
output is connected to the Osprey card’s input.

2. Check that the correct video input is selected in the Control Dialog’s Source
page.
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Blue Video Screen when using DV or SDI
inputs

Check to make sure the Osprey-100 Analog mode is not selected in the Advanced
Features Tab of the video control dialog. This option could have been previously
manually selected or automatically selected with previous releases (1.0.5 and
earlier) if the user last ran a non-certified application.

Black Preview Video Screen

If you select a Color Format other than one of the RGBs or Grey8, you may get a
black preview screen. You may also get a message such as “Error: Unable to draw
this data format”. The problem is that Video for Windows does not know how to
decode these more specialized formats. It must be able to locate a software video
decompressor on your system that works with this format.

If you encounter this situation with a Color Format that you need or want to use, you
have to obtain a suitable compressor. For example, if you install Intel’s Indeo
compressor you can preview the YVU9 format. To download from Intel's web site:

http://www.ligos.com/indeo/downloads/

Scrambled Video Image

You may have set the wrong video signal format for the signal input you are using.
For example, you may have told the driver to look for NTSC-M video but are using a
PAL-BDGHI video source. Make sure you know what signal format your video source
is generating. Go into the Video Standard field of the Control Dialog’s Source page,
and click the button for that signal format.

Grainy, Dithered Image

Check that you are using a display format with greater than 256 colors. If a 256
color format is used, the system can only approximate the actual colors, and does so
with a loss of resolution and precision.
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Slow Overlay Drawing

You should be able to obtain 30 frames per second with minimal processor loading
by enabling Direct Draw. System requirements for realizing this speed are:

¢ avideo display card that supports Direct Draw
¢ avideo display device driver for the card that supports Direct Draw

Either or both of the two checkboxes in the Direct Draw field of the Control Dialog’s
Configuration page must be checked.

Refer also to Appendix E - Direct Draw.

Problems using Direct Draw

Direct Draw is a recent technology and it is possible that you may have problems
using it with your particular combination of display adapter, display driver, and
machine. Any problems should arise only when Overlay mode screen drawing is in
use; the Osprey card does not use Direct Draw at other times. If you do have
problems, disable either or both Direct Draw methods by unchecking their boxes in
the “Direct Draw” field of the Control Dialog’s Configuration page. We have seen
problems with Secondary Direct Draw on a few older display adapters. Refer also to
Appendix E - Direct Draw, for more details.

Poor Video Quality at Large Frame Sizes

Large frame sizes with the deep pixel depth (24- or 32-bit), or complex format
(YVU9 or YUV12 planar), impose heavy demands on the PCI bus’s data transfer
capacity. Our experience is that some systems cannot handle these formats at full
frame sizes.

Systems vary in their data transfer limits. The characteristics of the PCI bridge are
often more important than processor speed. If you are having problems, we
recommend that you:

Use a smaller frame size (480 x 320 or less).
Use a shallower color format (RGB15 or RGB24 instead of RGB32).

Try an RGB format instead of a YVU format, and a packed format instead of a
planar format.

¢ If you have a choice of PCs for video capture, try using another system with a
different system board chipset.
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Wrong Capture Driver Being Accessed

This might happen if you already had another capture board/capture driver on your
system when you installed the Osprey card. The Osprey installation procedure allows
you to set the Osprey driver as either the primary or secondary video capture driver.
Appendix D - Using the Osprey Video Capture Driver with Other Video Capture
Drivers gives a full description of how to set the Osprey driver as the primary driver.

Some applications, including VidCap32, allow you to select which video capture
driver to use. In VidCap32, a list of installed video capture drivers is appended to the
bottom of the Options menu.

Unwanted Closed Caption Text

Closed Caption text consists of white or colored characters drawn on black character
cells.

In video that contains Closed Captioning information, the first active line of video in
each field contains encoded Closed Caption text. In video that does not have Closed
Captioning information, that line is simply ordinary video.

9 PAL video sources do not contain Closed Caption text.

If you leave Closed Captioning enabled and view non-Closed Caption video, the
Osprey video capture driver attempts to interpret the first line of each field of video
as Closed Caption character codes. Some video may display sufficiently similar to
Closed Caption data that the software thinks it is Closed Caption text. The result is
occasional randomly drawn text appearing on the screen.

The solution is to turn off Closed Captioning when you are viewing sources that are
not Closed Captioned. To do so, open the Control Dialog’s Closed Caption page and
uncheck the Enable box in the Display field. The change takes effect when video is
restarted after exiting the dialog.

For more information about Closed Captioning, refer to The Closed Caption Page.

No Closed Captions on Digital Video

The Osprey-500 is capable of decoding closed captions on NTSC video inputs. This
feature is supported on analog video sources - the composite and svideo inputs,
only. It is not supported on the digital video inputs - SDI and DV.
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Interrupt Conflicts

Failed network connections, failure of a device drive to initialize during start-up, or
failure of the Osprey card and driver to operate properly are often traced to interrupt
(IRQ) conflicts. In our experience, IRQ conflicts are most commonly seen when a PCI
SCSI adapter, or possibly a PCI network adapter, is present in the system.

Conflicts Between PCI Cards

Conflicts of PCI Cards with ISA Cards

Conflicts Between PCI Cards

PCI cards and drivers do not choose which IRQs they use; rather, the operating
system assigns IRQ lines to PCI cards. The IRQ configuration for the Osprey card or
cards is determined by Windows NT, and the Osprey driver cannot change this
configuration. However, you can cause the operating system to assign IRQs
differently by rearranging cards or changing BIOS settings.

Multiple PCI cards are supposed to be able to share the same IRQ line. In practice,
occasionally you may encounter a device driver that is not implemented correctly for
interrupt sharing. If this problem arises, you have to rearrange the PCI cards so that
the non-compliant card does not share its IRQ line with any other device.

Another problem is that some PCI device drivers expect to use a particular IRQ line.
When a new card is added, it causes the system to assign IRQs differently. If the IRQ
assignment for a particular card is changed and its device driver does not detect the
change, this causes the system to work incorrectly.

The simple answer to this problem is it can sometimes be solved by physically
rearranging the PCI cards such that their arrangement in the PCI slots is different.
When doing this, keep careful notes of the arrangements you have tried.

Another approach to PCI card conflicts is at the BIOS level. Depending on what kind
of system BIOS you have, you may be able to change which IRQ lines are allocated
to PCI devices versus ISA devices. You may be able to allocate more IRQ lines for
PCI devices and thereby solve a PCI conflict.

If these approaches do not work, see Getting Help in Chapter 1.

Conflicts of PCI Cards with ISA Cards

A PCI card and an older-style ISA card can never share IRQ lines. Windows NT
cannot detect with certainty what IRQ line an ISA card is using and cannot always
prevent the conflict.
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You can view the system’s IRQ assignments by running the Windows NT Diagnostics
program in the Administrative Tools menu or program group. Select the Resources
tab and click the IRQ button at the bottom of the field. If the list of cards shows an
ISA card using the same IRQ as another device, the conflict should be resolved by
changing the IRQ of the ISA card.

Unfortunately, if a device driver for an ISA card has failed to initialize because of an
IRQ conflict, the card’s IRQ does not display in the list. To find the conflict, you have
to examine all your ISA cards with the Control Panel to find out what IRQs they are

trying to use.

Multiple Horizontal Lines Across Video
Image

If there are multiple, regularly spaced, horizontal lines across your video image and
your source material is copyrighted and copy-protected, you are seeing
Macrovision ™ copy protection. It looks like this:

B vidvien E =10l =]
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& & =

The lines can vary in color from yellow to blue to green. These lines are not present
in every frame of video. There may also be a black band at the top of the frame.

The Osprey-500 cannot eliminate these video artifacts. These artifacts are only
present when you are using a copy-protected source, such as a high-quality DVD for
testing a card.
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Cannot Play Back Audio Recorded by the
Osprey-500 Card

Verify that the selected playback device is your sound card, and not the Osprey-500
Placeholder device. The Placeholder device exists in order to handle the situation
where there is an Osprey-500 present without a sound card. Some Windows
applications cannot use a recording device unless a playback device is also installed.
The Placeholder device cannot play back recorded audio. You can use the same
method to select playback device that you use when selecting the audio source.

If you have a sound card installed, you should be able to hear audio when you play
back recorded audio.

Verify that the volume control for your playback device is not muted.

Video Control Dialog Windows are Empty
under WinNT

This problem occurs only for Windows NT installations that are running Service Packs
earlier than SP4, or that are running versions of Internet Explorer earlier than
version 4. The problem is caused by the Osprey driver software's use of features
(window dialog controls) provided by Windows NT that were introduced in 1999.

This problem can be fixed by:
+ applying NT Service Pack 4 or later.

Service Pack 6a is required to use Microsoft's Windows Media Encoder 7.1
and Media Player 7.1.

+ installing Internet Explorer version 4 or later

+ downloading and installing the latest version of 401Comupd.exe from
Microsoft's website at
http://www.microsoft.com/msdownload/ieplatform/ie/comctrix86.a

sp
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Appendix A - Hardware Specifications

The physical specifications for the Osprey-500 Capture Cards are as follows.

Table A-1 Physical Dimensions

Length 133 mm
Width 22 mm
Height 121 mm
Weight 63 grams

Table A-2 Environmental Specifications

Operating temperature range 0° to 40° C

Non-operating temperature range -400 to +75° C (RH)

Operating humidity range Between 5% and 80% (non-condensing)
@ 40° C

Non-operating humidity range 95% RH (non-condensing); gradient
30% per hour

Operating altitude range 0 to 3,048 meters (10,000 feet)

Non-operating altitude range 0 to 15,240 meters (50,000 feet)
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Appendix B - Color Modes

The Color Format field of the Control Dialog’s Format page allows you to select the
following video formats.

RGB32 - Each pixel has four bytes (32 bits) of data - one each for red, green, and
blue, plus one byte of padding. The pixel has 256 shades of each of the three colors,
for a total of 16.7 million colors. This is a “true color” mode.

RGB24 - Each pixel has three bytes (24 bits) of data - one each for red, green, and
blue. This is another “true color” mode with 16.7 million colors, and is a
recommended format for capturing images with the highest possible color accuracy.

RGB15 - Each pixel has two bytes (16 bits) of data. There are 5 bits each of red,
green, and blue data; the sixteenth bit is unused. This is a “high color” mode, also
known as “5:5:5.”

Grey8 - Each pixel has one byte of data, representing one of 256 greyscale levels.

4:2:2 packed - Also known as YUY2. This mode represents each pixel with a total
of 2 bytes (16 bits) of data. The data is encoded as separate data for luminance
(intensity) and chrominance (color). This mode is mainly used as an input to
software compressors. See below.

YUV12 planar - Also known as I420. This is a complex format in which there are in
the aggregate 12 bits of data per pixel. Each pixel has 8 bits of luminance data. Each
group of 4 adjacent pixels shares two bytes of chrominance data. See below.

YVU9 planar - Similar to YUV12 planar, except that there are in the aggregate 9
bits of data per pixel, and each byte pair of chrominance data is shared by 16
adjacent pixels.

YUV Format Details

YUV Format Details

4:2:2, YVU9, and YUV12 are YUV formats. In these formats, each pixel is defined by
an intensity or luminance component, Y, and two-color or chrominance components,
U and V. Since the human eye is less sensitive to color information than to intensity
information, many video formats save storage space by having one luminance byte

per pixel while sharing the chrominance byte among two or more pixels. YUV is also
very similar to the color encoding used for analog color television broadcast signals.

4:2:2 packed mode consists of a single array of mixed Y, U, and V data. Each pixel
has one Y (intensity) byte. Each pixels shares its U and V bytes with one of the pixels
horizontally next to it:
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Pixels 1 and 2:

byte 1l =y1 byte 1 intensity

byte 2 = u1/2 shared U color information for bytes 1 and 2
byte 3 = y2 byte 2 intensity

byte 4 = v1/2 shared V color information for bytes 1 and 2
Pixels 3 and 4:

byte 5 = y3

byte 6 = u3/4

byte 7 = y4

byte 8 = v3/4

4:2:2 packed mode uses the same number of aggregate bytes per pixel as RGB15,
which is two. However, 4:2:2 is more efficient than RGB15 because it stores
relatively more of the intensity information to which that the human eye is most
sensitive.

YVU9 and YVU12 are "planar" modes - the Y, U, and V components are in three
separate arrays. It is easiest to explain the format with an example: Let's say you
have a 320x240 YVU9 format. The buffer has 320x240 bytes of Y data, followed by
80x60 bytes of V data, followed by 80x60 bytes of U data. So each U and each V
byte together contain the color information for a 4x4 block of pixels.

Similarly, a 320x240 YUV12 format has a 320x240 Y array, followed by a 160x120 U
array, and then a 160x120 V array.

Note that in the 1420 format used by Osprey, the order of the U and V
arrays is reversed from the order in the YVU9 format.
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Appendix C - Video Sizes

The table below gives the standard video sizes available through the Control Dialog’s

Format page.

The 525-line video formats are NTSC-M, NTSC-J, and PAL-M.

The 625-line video formats are PAL-BDGHI, PAL-N, and PAL-NC.

CCIR601 is a video proportioning standard that can be selected on the Control
Dialog’s Format page.

Available Video Sizes (Width x Height:)

525-line 525-line 625-line 625-line

(Sqr Pixels) (CCIR601) (Sqr Pixels) (CCIR601)
Full 640 x 480 720 x 480 768 x 576 720 x 576
1/2 (CIF) 320 x 240 360 x 240 384 x 288 360 x 288
3/8 240 x 180 270 x 180 288 x 216 270 x 216
1/4 (QCIF) 160 x 120 180 x 120 192 x 144 180 x 144
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Appendix D - Using the Osprey Video
Capture Driver with Other Drivers

If you already have a video capture driver installed in your system, the Osprey
installation software offers the option of installing the Osprey driver as your primary
video capture driver. A dialog box with that option displays near the end of the
installation sequence.

The Windows 2000 and Windows XP installer does not offer this option.

After installation, you can change the primary video capture driver by going to the
Configuration Page of the driver's setup dialog and then to the Default Capture
Device option.

If the Osprey driver is set as your primary video capture driver, it automatically
connects to Video for Windows applications as the default driver. If you install it as a
secondary or auxiliary video capture driver, it is not be accessible to Video for
Windows programs and utilities that lack a control for selecting a specific capture
driver. Your other driver, however, remains immediately accessible as the default
driver.

What if you have a need to change drivers and capture cards, once or repeatedly?
The most safe-and-certain way is to run the old driver’s uninstall program and then
run the new driver’s install or setup program. You may find it easier, however, to use
the system Control Panel to remove and install drivers.

The Control Panel’s "Remove” does not actually remove a driver permanently from
your system. Its files are still in the same locations on your hard disk. Rather, it
alters the registry settings so that the driver does not appear on the list of active
drivers. When you later “"Add...” a driver that is removed in this way, you have the
choice of using the existing files, or copying in new ones.

Use the Control Panel’s Multimedia Add... function to activate the primary driver you
want. The Add... function replaces the previous primary driver with the new one.
This is usually in fact what you want to do. There is no way to designate a driver as
secondary or auxiliary using the Control Panel.

Because the NT 4.0 Add... function acts more like a “Replace...” function if a driver
is already there, the Remove function is not really needed. This is fortunate,
because it does not work for all video capture drivers. It appears to, but the registry
does not actually get updated. (For the Osprey driver, the Remove function does
work.) If both a primary and a secondary driver are installed, and you Remove the
primary driver, and the function works correctly, the secondary driver becomes the
primary driver.

To "Add..." a driver, proceed as follows:

To "Remove" a driver, proceed as follows:
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To "Add..." a driver, proceed as follows:

The following information is valid for Window NT 4.0 only, not for
Windows 2000 and Windows XP.

1. Open My Computer and double click on the Control Panel icon. The Control
Panel window will come up.

2. Double click on the Multimedia icon. The Multimedia Properties window will
come up.

3. Click on the Devices tab. A list of multimedia devices will appear.
4.  Click on the Video Capture Devices selection; it should become highlighted.

5. Click the Add... button at the bottom of the window. A window titled Add
appears, with a list of drivers.

6. If the driver you want to add is in the list, highlight it and click OK. Follow
whatever further directions come up that are specific to the driver.

7. If the driver you want is not on the list, highlight the first item, Unlisted or
Updated Driver, and click OK.

8. You now get a dialog that prompts for a pathname. You have to provide the
location of an “INF” file for the driver. This is a file belonging to the driver of
interest entitled "0100drv.inf”. You can either type in the path or click the
Browse... button to select the path. For the Osprey software, this file will be in
the directory where the software was installed, by default \Program
Files\Osprey Multimedia Capture on the default drive. When you have the
correct path in the dialog, click OK.

9. A dialog entitled Add Unlisted or Updated Driver will now come up. There could
be several choices of drivers; if so, select the one for a video capture driver and
click OK.

10. Follow any further directions specific to the particular driver that come up.
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To "Remove" a driver, proceed as follows:

The following information is valid for Window NT 4.0 only, not for
Windows 2000 and Windows XP.

1. Open My Computer and double click on Control Panel. The Control Panel
window will come up.

2. Double click on the Multimedia icon. The Multimedia Properties window will
come up.

Click on the Devices tab. A list of multimedia devices will appear.

Click on the plus sign to the left of small icon marked Video Capture Devices.
Click on (and highlight) the video capture device you want to remove.

Click on the Remove button at the bottom of the window.

A confirmation dialog will come up. Click Yes to deactivate the driver.

Verify that the driver was actually removed by closing the Multimedia window,
restarting it, and seeing if the driver is in fact gone from the Video Capture
Device list.

NV AW
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Appendix E - Direct Draw

Direct Draw is a fast on-screen drawing method. The Osprey video capture driver
utilizes Direct Draw for drawing video overlays. Video overlay is a display mode
available in most video capture applications, including VidCap32. It is enabled by
clicking an Overlay button, or by selecting an Overlay menu entry. It is distinct from
Preview mode. Preview mode does not utilize Direct Draw.

Direct Draw is enabled by the Direct Draw Enable checkbox on the Control Dialog’s
Configuration Page. When Direct Draw is enabled, the Osprey driver attempts to
use it for overlays. If it cannot (e.g., the display driver does not support Direct
Draw), the Osprey driver defaults to DibDraw.

When Direct Draw is used, video is copied by direct memory access (DMA) directly
from the Osprey board to the visible screen memory, and video is overlaid at 30
frames per second with very low main processor utilization. When Direct Draw is not
used, video is copied by DMA into system memory, and then copied again into
display memory. Frame rate without Direct Draw is 30 per second for smaller frame
sizes, but less for larger sizes, and processor loading is substantial.

In order to utilize Direct Draw, the following conditions must be met:

1.  You have to enable Direct Draw by checking the Enable button on the Control
Dialog’s Configuration page.

2. Your video display card must support Direct Draw.

3. The software device driver for your video display card must support Direct
Draw. It is recommended that you use the most recent driver available. The
drivers on the Windows NT 4.0 CD-ROM do not support Direct Draw in all cases.
You can obtain the most recent version from your video card manufacturer’s
web site.

4.  You must be using a video format other than Grey8. The Osprey driver does not
support Direct Draw of greyscale video.

5.  You can tell whether the system is using Direct Draw as follows: When Direct
Draw is in use, the display near the video capture window flickers when either
the video capture window or an overlapping menu or window is moved. When
DibDraw is being used, there is no flicker.

6. You can also measure CPU utilization using the Task Manager’s performance
meter. When measuring CPU utilization, first shut down any applications that
might be actively consuming significant CPU time. CPU utilization is just a few
percent when Direct Draw is running. If DibDraw is running, CPU utilization is
substantial, especially if the image is large.
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Appendix F - Multiboard Installations

The multiboard capability of the Osprey-500 Capture Driver allows both single and
multiple applications to simultaneously access multiple boards. However, the driver
does not allow multiple applications or processes to access a single board unless the
added-cost SimulStreaming option has been enabled for the board, or another
special circumstance exists.

First, some background on the logic by which the Osprey-500 driver determines
connection or startup order for multiple boards. The numbering of the boards is
determined by the order in which the operating system recognizes their presence in
the slots in which they are installed. The arrangement of logical PCI slots is different
for different machines, and you should experiment to determine which physical
board is Board 1. Also, the humbering under Windows 2000 or Windows XP may
differ from the numbering under Windows NT 4.0.

Every time the system is rebooted, the Osprey-500 drivers re-enumerate the boards
in the system and make unique video capture entries for each board. If the Multiple
Opens box is not checked under Access for Multiple Boards on the Configuration
Page of the Osprey-500 Video Control Dialog, a "default" registry entry is made that
represents the legacy method of opening multiple devices, as well as registry entries
for individual boards. If the box is not checked (selecting the check box is
recommended), only entries for specific cards are created.

The Recommended Multi-Board Selection Approach

The Legacy Multi-Board Selection Approach

The Recommended Multi-Board Selection
Approach

The recommended method is to check the Multiple Opens box on the Configuration
Page of the Osprey-500 Video Control Dialog. Checking this box should result in the
generation of only individual device names as video capture device entries. For
example, the following msvideo entries display for two Osprey-500 devices in the
system:

¢ 0500vc.dll - Osprey-500 Card 1
¢ 0500vc.dll - Osprey-500 Card 2

These "Card 1" / "Card 2" names should be used when opening the Osprey-500. In
the event that you see a "Card Default" entry (see the legacy approach below), this
is for legacy applications that did not allow for specific device selection.
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The Legacy Multi-Board Selection
Approach

The non-recommended method is to not check the Multiple Opens box on the
Configuration Page of the Osprey-500 Video Control Dialog. Not checking this box
should result in the generation of individual device names as well as Card Default
name as video capture device entries. For example, the following msvideo entries
display for two Osprey-500 devices in the system:

0500vc.dll - Osprey-500 Card Default
0500vc.dll - Osprey-500 Card 1
0500vc.dll - Osprey-500 Card 2

If two or more boards are installed and you use the default device nhame to access
the Osprey driver, it first connects to the default board. Normally, the default board
is whichever board was most recently selected in the Control Dialog's Board Select
field. If this default board is in use (and the MultiOpen option is turned off), the next
available board is automatically selected. Once any board is selected, you can
change it to a different board by selecting the desired board in the application you
are using (often under a menu titled Options or Board Select).

Multiple boards may be accessed according to two main scenarios:

¢ Multiple processes accessing multiple boards: Start two standard applications
- or two copies of one application - such as VidCap32. The first copy comes up
connected to the default board and starts normally. The second copy
automatically hunts for the next available board in ascending numerical order.

¢ A ssingle application accessing multiple boards: A single custom application
can access two or more different boards. If the standard Video for Windows
interface is used, the access order is the same as described above.

¢ Multiple applications accessing single board: If you have the added-cost
SimulStream upgrade, then multiple applications can access a single board.
This option is described in detail in the SimulStreaming User's Guide.

Multiple Opens is much more precise and flexible for custom applications that use the
Osprey Video For Windows NT/2000 Software Developers' Kit (VFW SDK). This kit
allows you to override the default board in order to access any board at any time. It
is recommended that developers of multiple board applications obtain this kit,
described in Appendix K. Please inquire at mailto:info@ospreyvideo.com for more
information.
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Appendix G - File and Registry Usage

The following are files that are written and registry entries that are set when Osprey
drivers are installed. This information allows a technically proficient user to remove
the Osprey-500 installation if the uninstaller is deleted or damaged.

Instructions for Windows NT 4.0

Instructions for Windows 2000 and Windows XP

These instructions are for advanced users only!

Chapter 4 - Installing the Software — Windows XP, or Chapter 5 -
Installing the Software - Windows NT 4.0 to remove the software.
Be careful not to delete or alter any items other than the ones
described here!

i Refer to Chapter 3 - Installing the Software - Windows 2000,
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Instructions for Windows NT 4.0

1. Entries are added in the multimedia and system portions of the registry. When
manually removing the software, use the Control Panel to "Remove” the driver
(and delete these entries) before deleting individual files and registry entries.

2. In the main Windows NT ..\System32 directory, these files can be removed:

Hutt_merge.rbf
Jedi.rbf
0500board.dll
0500vc.dll
o5ca_mix.dll
o5ca_usr.dll
o5ca_wav.dll
otiyuv.dll
SimulKey?2.dll

3. In the main Windows NT ..\System32\drivers directory, these files can be
removed:

0500drv.sys
o5ca.sys

4. The Osprey 500 install driver directory, its subdirectories, and its files can be
removed. Typically, this directory is \Program Files\Osprey 500 on the default
drive. The installation procedure puts the following files common to Windows
NT in that directory:

CropApp.exe
CroppingManual.pdf
license.txt

Osprey-500 Special Offers.url
Osprey-500UsersGuide.pdf
osprey.ico

Readme.txt

SimulStream Special Offers.url
SimulStreaming_Users_Guide.pdf
VidCap.hlp

VidCap32.exe

xctlapp.exe

Driver directory

5. The installation program also creates a directory called NT within the Osprey
500 install directory which contains the following files:

files DelsL*.isu

VCLogo.bmp

VCST1.bmp

VCST2.bmp

the Help subdirectory and all its contents

6. In the registry the following branches are added and can be deleted without
affecting the rest of the system. Use RegEdit to delete them.

In this branch of the registry, the "1" on wave, mixer, and msvideo may
be a different numeral, or may not be present.
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HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\
Drivers32 device entries:

"wavel"="o5ca_wav.dll"
"mixerl"="05ca_mix.dll"
"msvideol1"="0500vc.dll - Osprey-500 Card 1"

HKEY_CURRENT_USER\Software\Osprey\Osprey500

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\drivers.desc entries:

"0500vc.dll"="0Osprey-500 Video Capture Driver"
"o5ca_wav.dll"="0sprey-500 Audio Wave Driver"
"o5ca_mix.dll"="0sprey-500 Audio Mixer Driver"

HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey500
HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast Corporation\Osprey Video
Division\Osprey 500
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins
tall\Osprey 500
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\o500drv
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\O5CA
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet003\Services\o500drv
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet003\Services\O5CA
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o500drv
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\O5CA
HKEY_USERS\.DEFAULT\Software\Osprey\Osprey500

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Drivers32 codec entries:

"vidc.I420 = otiyuv.dll"

"vidc.yuy2 = otiyuv.dll"

You can delete the Taskbar entry by selecting Taskbar Properties -> Start
Menu Programs -> Remove.
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Instructions for Windows 2000 and
Windows XP

Entries are added in the multimedia and system portions of the registry. When
manually removing the software, use the Control Panel to "Remove" the driver
(and delete these entries) before deleting individual files and registry entries.

In the main Windows 2000 or Windows XP ..\System32 directory, these files
can be removed:

Hutt_merge.rbf
Jedi.rbf
0500vc.dll
o5ca_wav.dll
o5ca_mix.dll
o5ca_usr.dll
0500board.dll
otiyuv.dll
Ouno500.dll
OtiPnp.dll
SimulKey?2.dll

In the main Windows 2000 or Windows XP ..\System32\drivers directory, these
files can be removed:

0500drv.sys
o5ca.sys

The Osprey-500 install driver directory, its subdirectories, and its files can be

removed. Typically, this directory is \Program Files\Osprey 500 on the default
drive. The installation procedure puts the following files common to Windows

2000 or Windows XP in that directory:

CropApp.exe
CroppingManual.pdf
osprey.ico

license.txt

Osprey-500 Special Offers.url
Osprey-500UsersGuide.pdf
Readme.txt

SimulStream Special Offers.url
SimulStreaming_Users_Guide.pdf
UsersGuide500.htm
VidCap32.exe

VidCap.hlp

xctlapp.exe

Driver directory

The installation program also creates a directory called NT within the Osprey-
500 install directory which contains the following files:

files Dels*.isu

VCLogo.bmp

VCST1.bmp

VCST2.bmp

the Help subdirectory and all its contents
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6. In the registry the following branches are added and can be deleted without
affecting the rest of the system. Use RegEdit to delete them.

In this branch of the registry, the "1" on wave, mixer, and msvideo may
be a different numeral, or may not be present.

¢ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\
Drivers32 device entries:

"wavel"="o5ca_wav.dll"
"mixerl"="o05ca_mix.dll"
"msvideol1"="0500vc.dll - Osprey-500 Card 1"

HKEY_CURRENT_USER\Software\Osprey\Osprey500

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\drivers.desc entries:

"0500vc.dll"="0Osprey-500 Video Capture Driver"
"o5ca_usr.dll"="0sprey-500 Audio Driver"
"o5ca_wav.dll"="0sprey-500 Audio Wave Driver"
"o5ca_mix.dll"="0sprey-500 Audio Mixer Driver"
"0500board.dll"="0sprey-500 Audio Board Driver"

HKEY_LOCAL_MACHINE\SOFTWARE\Osprey\Osprey500
HKEY_LOCAL_MACHINE\SOFTWARE\ViewCast Corporation\Osprey Video
Division\Osprey-500

¢ HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Unins
tall\Osprey-500

¢ HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Control\MediaResources\msv
ideo\!default entry: "Driver" = "0500vc.dll - Osprey-500 Card 1"

¢ HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Control\MediaResources\msv
ideo\!default entry: "Driver" = "0500vc.dll - Osprey-500 Card 1"

¢ HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\MediaResources\
msvideo\!default entry: "Driver" = "0500vc.dll - Osprey-500 Card 1

HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\O5CA
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services\o500drv
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\O5CA
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet002\Services\o500drv
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\O5CA
HKEY_ LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\o500drv
HKEY_USERS\.DEFAULT\Software\Osprey\Osprey500
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Drivers32 codec entries:

"vidc.I420 = otiyuv.dll"

"vidc.yuy2 = otiyuv.dll"

7. You can delete the Taskbar entry by selecting Taskbar Properties -> Start

Menu Programs -> Remove.

* & & 6 6 o o o
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Appendix H - Adding/Moving Boards in
Windows 2000 and Windows XP

Under Windows 2000 or Windows XP, when the driver has been installed and another
Osprey-500 board is put into a slot that has not previously contained a board, the
following sequence of windows is initiated. This can happen because an Osprey-500
board has been moved to a different PCI slot or when a board is been added to the
machine. It occurs because of the manner in which Windows 2000 and Windows XP
enumerates devices.

Windows 2000
Windows XP

Windows 2000

The Found New Hardware Wizard runs and displays two windows. First, a smaller
window with the text "Found New Hardware, Osprey-500 Video Capture Device,
Installing ..."

Found New Hardware -

Multimedia ideo Controller

Installing ...

The Digital Signature Not found window for the video portion of the Osprey-500
displays.

Digital Signature Not Found 1 x|

The Microzoft digital signature affirms that software has
been tested with Windows and that the software has not
been altered since it was tested.

The software you are about to install does not contain a
Microzoft digital signature. Therefore, there is no
guarantee that this goftware works comrectiy with
Windows.

Osprey-500 Yideo Capture Device

If pou want to zearch for Microzoft digitally signed
software, visit the Windaws Update Web site at
http:  Awindowsupdate. microsoft.com to see if one is
available.

Do o want to continue the installation?

No More Info
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1. Click Yes.

The Digital Signature Not found window for the audio portion of the Osprey-500
displays.

Digital Signature Mot Found o x|
The Microzoft digital signature affirms that software has
been tested with “Windows and that the software has not
been altered since it was tested.

The software you are about ta install does not contain a
Microzoft digital signature. Therefore, there is no
guarantee that this goftware works cormectiy with
Windows.

Osprey-500 Audio Capture Device

If pau want ta zearch far Micrazoft digitally signed
software, visit the "Windaws Update Web site at
http: //windowsupdate. microsoft.com to see if one is
available.

Do pou want to continue the installation?

No More Info

2. Click Yes.
When the Completing the Found New Hardware window displays, click Finish.

4. Two Digital Signature Not Found windows display for each Osprey-500 board
that you have added or moved.

The Systems Settings Change window displays.
5. Click Yes to restart your computer.

w

9 You computer must be restarted for the Osprey-500 card to behave as
expected.

Windows XP

The Welcome to the Found New Hardware Wizard detects an Osprey-500 has
been added or moved.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps you install software far:

Osprey-500 ¥ideo Capture Device

\') If your hardware came with an installation CD
B2 or Hloppy dizk. insert it now.

‘what do pou want the wizard to do?

() Install from a list o specific location [Advanced)

Click Mest to continue.

I MNest » l[ Cancel
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3.

4.
5.

Click to select Install the software automatically

Click Next.

After completing the search, the Hardware Installation window displays,

covering the previous window.

Hardware Installation

] E The zoftware you are ingtalling for this hardware:
.

Osprey-500 Yideo Capture Device

has not pazsed 'Windows Logo testing to werify its compatibility

with ‘windows *P. [Tell me why this testing iz important. |

Continuing your installation of thiz software may impair
or destabilize the comrect operation of your system
either immediately or in the future. Microzoft strongly
recommends that you stop thig installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

Continue Aryway ] | STOF Installation |

Click Continue Anyway.
The Files Needed window displays.

Click Browse to locate the Program Files\Osprey-500\driver directory

Click OK.

Files Needed 3]

. The file '0500dr.sys' on Osprey-500 Driver Installation

Cancel

=  Mediais needed.

Type the path where the file iz located, and then click
oK.

LCopy files from:

C:\Program Files\0sprey-5004driver w

A Copy Error window displays.

Copy Error @

@ Setup cannot copy the file Jedirb.

Enzure that the location specified below is comrect, or
change it and insert "0zprey-500 Driver Installation
Media' in the drive vou specify.

LCopy files from:

[ExwirsP v
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6. Click Browse to locate the systemroot\system32 (usually
\WINNT\system32) directory.

7.  Click to select Jedi.rbf
8. Click OK.
The Completing the Found New Hardware Wizard window displays.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard

The wizard has finished instaling the software for:

@_ O zprep-500 Yideo Capture Device

Click Finizh to close the wizard.

9. Click Finish.
The Welcome to the Found New Hardware displays. [ file 0500xp-apph-8.bmp]

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

Thiz wizard helps you install software far:

Osprey-500 Audio Capture Device

\'j If your hardware came with an installation CD
“4E2 or floppy disk. insert it now.

‘what do pou want the wizard to do?

() Install from a list o specific location [Advanced)

Click Mest to continue.

I MNest » l[ Cancel
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10. Click Next.
The Hardware Installation window displays.

Hardware Installation

] E The software you are installing for this hardware:
L

Ogprey-500 Audio Capture Device

haz not pazsed ‘Windows Logo testing ta werify itz compatibility

with ‘Windows %P, [Tell me why this testing iz important. ]

Continuing your installation of this software may impair
or destabilize the cormrect operation of your system
either iImmediately or in the future. Microzoft strongly
recommends that you stop this installation now and
contact the hardware yendor for software that has
pazzed Windows Logo testing.

Continue Aryway ] [ STOP Installation |

11. Click Continue Anyway.
The Systems Settings Change window displays.
12. Click Yes to restart your computer.

9 You computer must be restarted for the Osprey-500 card to behave as
expected.
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Appendix I - The Audio Cfg Applet

The Audio Cfg Applet has been removed from the release. Please see Registry
Settings Controlled by the Audio Cfg Applet for information about changing the
Rate Conversion Selection and Gain Selection.

Riate Conversion:

¥ Filter Corrverter Previous Settings |
€ Skip Corverter

" Microsoft PCM Converter —.l

Drefault Settings

Apply | Cancel I

Mono Selection

This selection indicates how Mono Audio is being presented to the Osprey-500.
Typically, Mono audio is carried through a single line or wire. To use single line Mono
capture, select Left Channel Mono. If you prefer to convert two audio channels to a
single channel, select Left+Right Channel Mono.

Rate Conversion Selection

This function selects the method that the Osprey-500 uses to convert audio from one
sampling rate to another. For example, audio from a DV source is typically 48 kHz
stereo audio. For various reasons you may want to capture audio at only 8 kHz. This
function selects the method that the Osprey-500 uses to convert between data rates.
For most purposes the default setting of Filter Converter works well.

Gain Selection

The Gain Selection allows you to boost the audio level. The default value of 2 is
sufficient for recording from most sources including camcorders, CD players, and
Walkman radios. If you have audio sources that are at lower levels, increase the
Gain value.

Default Settings
Restores the default settings which are shown in the screen above.
Apply

Once all options on the Osprey-500 Audio Settings screen are selected, click Apply.
All audio applications using the Osprey-500 share these settings.
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Registry Settings Controlled by the Audio
Cfg Applet

The Audio Settings applet places registry values in these twigs of the registry:

¢ HKEY_CURRENT_USER\SOFTWARE\Osprey\Osprey500\DeviceX\Audio\RateCo
nversion

RateConversion may be set to 1, 2, or 3 only.
When RateConversion is:
1 - use filter converter (default)
2 - use skip converter (skips samples)
3 - use Microsoft PCM method
¢ HKEY_CURRENT_USER\SOFTWARE\Osprey\Osprey500\DeviceX\Audio\Gain

The default value of Gain is 2. Set it higher for increased software audio gain.
Set it below 2 to decrease gain.
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Appendix ] - Developer Support

The Osprey Technologies group has a software developers’ kit (SDK) to assist
development of specialized Video for Windows applications. The Osprey Video for
Windows NT/2000/XP SDK provides capabilities that the Video for Windows API does
not provide. It uses a proprietary interface that bypasses Video for Windows and
connects your application directly to the Osprey video capture driver.

The developers’ kit at present has the following modules:

L2

* & 6 & o o

Methods by which a single application can access multiple boards - see also
Appendix F.

Interactive control of video source, brightness, contrast, hue, and saturation
from inside an application

A Closed Captioning API, by which the application can control Closed
Captioning and capture Closed Caption text for specialized processing and
display.

An API for controlling cropping parameters (see the CropApp manual).

An example of the Audio Mixer program.

An API for Controlling on-video logos - see Chapter 6, The Logo Page.
An API for capture of raw Vertical Blanking Interval (VBI) data.

Direct access to the Bt878 registers.

Please inquire at mailto:info@ospreyvideo.com for further information.
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